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ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP  

 
 ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP เปนชุดทดลอง “dsPIC” ขนาดเล็ก โดยตัว
บอรดไดรับการออกแบบใหสามารถรองรับการศึกษาเรียนรูเกี่ยวกับสถาปตยกรรมของไมโครคอนโทรลเลอร
ตระกูล dsPIC จากคาย Microchips ในขั้นพื้นฐานไดอยางครบถวน ภายใตงบประมาณที่เรียกวาประหยัด
และคุมคามากที่สุด โดยตัวบอรดเลือกใช MCU เบอร dsPIC30F2010 เปน CPU ประจําบอรด พรอมทั้งจัด
วงจรพื้นฐานอื่นๆที่จําเปนรวบรวมไวภายในบอรด ไมวาจะเปนแหลงจายไฟ วงจรแสดงผลการทํางานของ 
Output แบบ LED ,วงจรสรางสัญญาณ Input Logic แบบ Push-Button Switch ,วงจรสรางสัญญาณ 
Input Analog แบบใชตัวตานทาน ปรับคาแรงดัน 0-5V ,วงจรกําเนิดเสียงดวยลําโพงขนาดเล็ก ,วงจร Line 
Driver สําหรับพอรตสื่อสารอนุกรม RS232 และวงจร Download แบบ ICSP เปนตน 
  นอกจากนี้แลวตัวบอรดยังไดออกแบบใหมีพื้นที่สําหรับใชตอทดลองวงจรขนาดเล็ก โดยมีทั้งสวนที่
เปนลาย PCB แบบจุดไขปลา หรือ อาจติดตั้งแผง Photo Board ขนาด 360 จุดเพื่อใชเปนพื้นที่ตอวงจร
ตางๆเพิ่มเติมไดเองตามตองการโดยใชชุด “ET-Hardware KIT” นอกจากนี้แลวยังสามารถนําบอรด I/O 
ขนาดเล็ก ซึ่งทางทีมงาน อีทีที จัดเตรียมไวเปนทางเลือกและสนับสนุนการทดลอง ซึ่งเรียกวาชุดโมดูลการ
ทดลอง “Mini I/O Module” แบบตางๆ ไมวาจะเปน ชุดทดลอง DC-Motor ,ชุดทดลอง Stepping Motor ,
ชุดทดลอง I2C ตางๆ ซึ่งมีทั้งชุดทดลอง I2C I/O PCF8574 ,ชุดทดลอง I2C EEPROM 24xx ,ชุดทดลอง 
I2C RTC เบอร DS1307 ,ชุดทดลอง I2C RTC เบอร PCF8583 ,ชุดทดลอง SPI โดยใช SPI Output เบอร 
74HC595 ,ชุดทดลอง Matrix Keyboard ขนาด 4x4 ,ชุดทดลอง 7-Segment ฯลฯ 
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คุณสมบัติของบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 EXP 
บอรด ET-dsPIV30F2010 TRAINING KIT V1.0 EXP จะประกอบไปดวย วงจรพื้นฐานที่จําเปน

สําหรับการศึกษาเรียนรูและทดลองใชงานทรัพยากรตางๆของ MCU ตระกูล dsPIC โดยภายในบอรดได
จัดเตรียมวงจรใชงานที่จําเปนไวใหใชงานอยางครบถวนไดแก  

 ใช dsPIC30F2010 เปน MCU ประจําบอรด โดยขาสัญญาณตางๆจาก MCU จะถูก
จัดเรียงไวอยางเปนระเบียบ ผาน “Pin Header” พรอมลายพิมพขาว แสดงชื่อขาสัญญาณ 
อยางชัดเจน เพื่อใหงายและสะดวกตอการตอทดลองใชงานขาสัญญาณตางๆ โดยไมถูก
จํากัดหนาที่การใชงานดวยวงจรแบบใดแบบหนึ่ง ทําใหผูใชสามารถทดลองใชงานฟงกชั่น
ภายในผานขาสัญญาณตางๆ ของ MCU ไดโดยอิสระและครบถวนตามตองการ 

 วงจรแหลงจายไฟ แบบ Bridge Rectifier ขนาด 1A พรอมวงจร Filter สามารถใชกับ
แหลงจายไฟไดทั้ง AC และ DC ขนาด 14-18V 

 วงจร Regulate ขนาด +5V / 1A สําหรับใชงานเปนแหลงจายไฟเลี้ยงวงจรใหกับ MCU 
และอุปกรณการทดลองตางๆ พรอม LED แสดงสถานะสีแดง และจุด Connector 
เชื่อมตอใชงาน ทั้งตัวผูและตัวเมีย 

 วงจร Regulate ขนาด +13V / 100mA สําหรับใชเปนแรงดันโปรแกรม ในการ Download 
ขอมูลแบบ HEX File ใหกับหนวยความจําโปรแกรม (Flash) ของ MCU ภายในบอรด 

 วงจร Download แบบ ICSP โดยใชงานรวมกับ “ET-CAP10P V2.0” สําหรับใชพัฒนา
โปรแกรมใหบอรด พรอม LED แสดงสถานะสีเหลือง สามารถ Download HEX File จาก
คอมพิวเตอร PC ใหกับ MCU ในบอรดไดทันที โดยไมตองใชเครื่องมือโปรแกรมอื่นๆอีก 

 วงจร Line Driver สําหรับพอรตสื่อสารอนุกรม RS232 จํานวน 2 ชอง โดยเชื่อมตอกับ
สัญญาณ RC13(TXD) และ RC14(RXD) จํานวน 1 ชอง สวนที่เหลืออีก 1 ชอง จะปลอย
วางไวเปนอิสระ เพื่อใหผูใชสามารถตอทดลองการติดตอส่ือสาร RS232 โดยใชสัญญาณ
จาก Pin I/O อ่ืนๆของ dsPIC เชน ตอกับขาสัญญาณ RF2(RXD) และ RF3(TXD) ได 

 วงจร LED แสดงผลแบบ Sink Current ใชไฟเลี้ยง +5V โดยใช LED สีแดงขนาด 3mm. 
จํานวน 4 ชุด สําหรับใชในการทดสอบการทํางานของ Output ตางๆ 

 วงจรปรับแรงดัน 0-5V โดยใชตัวตานทานปรับคาไดแบบเกือกมาแบบมีแกนปรับ จํานวน 4 
ชุด สําหรับใชในการทดสอบการทํางานของ A/D  

 วงจร Push-Button Switch จํานวน 4 ชุด สําหรับใชทดสอบการทํางานของ Input ตางๆ 
 วงจร Mini Speaker สําหรับใชทดสอบการกําเนิดเสียง Beep หรือเสียงอื่นๆ 
 พื้นที่สําหรับบัดกรีวงจรเพิ่มเติมขนาด 8cm x 4.5cm หรือใชเปนพื้นที่ติดตั้ง Photo Board 
รุน AD100 ขนาด 360 จุด สําหรับตอทดลองวงจรตางๆ 
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คุณสมบัติของ dsPIC30F2010 
 dsPIC30F2010 เปน MCU ซึ่งใชการประมวลผลขอมูลแบบ 16 บิต จากคาย Microchips ซึ่งมี
จุดเดนในดานของความสามารถในการประมวลผลขอมลูสัญญาณแบบดิจิตอล สําหรับนาํไปประยุกตใชใน
งานควบคุมตางๆ โดยโครงสรางภายในจะเปนการผสมผสานระหวางไมโครคอนโทรลเลอร (MCU) และ
วงจร DSP (Digital Signal Processing) รวมเขาไวดวยกนั หรืออาจเรียก MCU ตระกูล dsPIC วาเปน 
DSC หรือ Digital Signal Controller ก็ได 
 ซึ่งในปจจุบัน MCU ในตระกูล dsPIC ของ Microchips นัน้จะมีการผลิตออกมาจาํหนายให
ผูใชงานไดเลือกใชงานกนัอยูมากมายหลายเบอรตามความเหมาะสมของงาน โดยปจจุบัน (ตุลาคม 2548) 
dsPIC จะแบงออกเปน 5 กลุม ใหญๆดวยกนั ไดแก dsPIC30F20xx ,dsPIC30F30xx ,dsPIC30F40xx 
,dsPIC30F50xx และ dsPIC30F60xx ซึ่งทกุเบอรจะใชโครงสรางและสถาปตยกรรมการประมวลผลแบบ
เดียวกนัทัง้หมด แตจะมีความแตกตางกนัในเรื่องของทรพัยากรภายใน เชน ขนาดของหนวยความจําใชงาน 
จํานวนของ Peripheral I/O แบบตางๆ ซึง่อาจมกีารบรรจุไวในแตละเบอรดวยจํานวนที่ไมเทากัน ซึ่งในที่นี้
จะขอกลาวถึงเพียงเฉพาะขอมูลในสวนทีเ่ปนของ dsPIC30F2010 เทานั้น 
 

คุณสมบัติดานการประมวลผล 
 ใชสถาปตยกรรมแบบ RISC โดยมี 84 คําสั่งมาตรฐาน รองรับการอางตําแหนงแอดเดรส
แบบตางๆไดโดยอิสระ โดยรูปแบบโครงสรางการจัดผังหนวยความจาํจะดัดแปลงมากจาก
สถาปตยกรรมของ “Harvard Architecture” 

 ชุดคําสั่ง ใชการอางแอดเดรสแบบ 24บิต และการอางถงึขอมูลขนาด 16บิต 
 มีหนวยความจําโปรแกรมแบบ Flash ขนาด 12KByte (4KWord) สามารถทาํการลบและ
โปรแกรมซ้ําใหมไดกวา 100,000 คร้ัง พรอมระบบปองกันการอาน 

 มีหนวยความจํา RAM ขนาด 512 Byte 
 มีหนวยความจําขอมูลถาวรแบบ EEPROM ขนาด 1KByte สามารถลบและเขียนซ้าํไดกวา 

1,000,000 คร้ัง และสามารถเก็บรักษาขอมูลไวไดแมไมไดจายไฟเลี้ยงให MCU  
 มีรีจิสเตอรขนาด 16 บิต ใหใชงานจํานวน 16 ชุด 
 สามารถประมวลผลดวยความเร็วสูงสุดที่ 30 MIPS(30 ลานคําสัง่ตอวนิาท)ี 
 รองรับสัญญาณนาฬกิาจากแหลงกาํเนิดภายนอก 0-40 MHz 
 รองรับการใชงานกับแหลงกาํเนิดความถี่แบบ XTAL คา 4-10 MHz 
 มีวงจรคูณความถี่ภายในแบบ Phase-Lock-Loop โดยสามารถกาํหนดคาอัตราการคูณ
ความถี่ได 3 ระดับ คือ 4 เทา ,8 เทา และ 16 เทา 

 รองรับการ Interrupt ไดถึง 27 แหลง พรอมสัญญาณ Interrupt จากภายนอก 3 แหลง 
และสามารถจดัระดับความสําคัญของการ Interrupt ได 8 ระดับ 
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คุณสมบัติของ Peripheral I/O 
 ขาสัญญาณ I/O สามารถจายกระแส(Source) และ รับกระแส (Sink) ไดมากถงึ 25mA 
 มี Timer ขนาด 16 บิต จาํนวน 3 ชุด และสามารถโปรแกรมใชงานเปน Timer แบบ 32 บิต
ไดโดยใช Timer  16 บิต 2 ชองรวมกนั 

 มี Input Capture ขนาด 16 บิต จํานวน 4 ชอง 
 มี Output Compare/PWM ขนาด 16บิต จํานวน 2 ชอง 
 มีวงจรสื่อสารอนุกรมแบบ SPI จํานวน 1 ชอง 
 มีวงจรสื่อสารอนุกรมแบบ I2C จํานวน 1 ชอง 
 มีวงจรสื่อสารอนุกรมแบบ UART จํานวน 1 ชอง 
 มีวงจร DCPWM สําหรับใชควบคุมมอเตอร 3 ชอง 
 มีวงจรถอดรหสัแบบ QEIM ขนาด 16บิต จํานวน 1 ชอง 
 มีวงจร A/D ขนาด 10บิต จํานวน 6 ชอง 

 

 
 

ตาราง แสดงความแตกตางของ dsPIC เบอรตางๆ 
 

 
รูปแสดง การจัดเรียงขาสัญญาณของ dsPIC30F2010 
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โครงสรางบอรด ET-dsPIC30F2010 TRAININGT KIT V1.0 / EXP 
 

อุปกรณภายในกรอบสีแดงจะไมมีอยู ในรุน “ET-dsPIC30F2010 TRAINING KIT V1.0” แตจะมี
อยูเฉพาะในรุน “ET-dsPIC30F2010 TRAINING KIT V1.0 EXP” เทานั้น 
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ขั้วตอ DOWNLOAD (ET-EMPIC) 
 
 

NC
WVCP
WPGD

NC

WVPP
WPGC
RPGD
NC

GND

DOWNLOAD(ET-EMPIC)

GND

 
 
 

 
 
 

รูปแสดง การเตรียมการ Download ของบอรด ET-dsPIC30F2010 
 

   ข้ัวตอ “DOWNLOAD” นี ้ จะใชสําหรับ 
เชื่อมตอกับชดุ “ET-CAP10PIN V2.0“   ผานทาง
ข้ัวตอของชุดที่ชื่อวา “ET-EMPIC” โดยใชสาย
แพรขนาด 10 Pin เปนสายเชื่อมตอสัญญาณ
ระหวางบอรดทั้งสองเพื่อใชสําหรับส่ัง Download 
HEX File ใหกับหนวยความจําโปรแกรม (Flash) 
ของ MCU ในบอรด “ET-dsPIC30F2010” 
ในขณะที่เลือกสวิตช “PROG/RUN” ไวทางดาน 
“PROG” โดยสามารถใชโปรแกรม “WinPic800” 
หรือ โปรแกรม “Melabs Programmer” เปนเปน
โปรแกรมสําหรับส่ังงานก็ไดตามตองการ 

ขั้ว DOWNLOAD 

ตอกับพอรต LPT 
(Printer Port) 

ใชขัว้ตอ ET-EMPIC 

16VAC/DC 
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การใชงาน LED แสดงผล 
 LED แสดงผลของบอรด จะตอวงจรแบบรับกระแส (Sink Current) โดยใชกับแหลงจาย +5V 
ทํางานดวยโลจิก “0” (0V) และหยุดทํางานดวยโลจิก “1” (+5V) โดยมทีั้งหมด 4 ชุด โดยวงจรในสวนนี้จะใช
สําหรับทดสอบการทาํงานของ Port I/O ตางๆทีท่ํางานใหผลเปน Output แบบโลจิก 
 

LED560
+5V

L
E

D
n  

 
การใชงานวงจรปรับแรงดัน (0V-5V) 
 วงจรปรับแรงดันของบอรดจะใชตัวตานทานปรับคาไดแบบเกือกมา ชนิดมีแกนหมนุสําหรับปรับคา 
โดยวงจรนี้ใชกับแหลงจาย +5V โดยจะให Output เปนแรงดันซึง่มีคาระหวาง 0V ถึง +5V ตามการปรับคา
ของตัวตานทาน ซึง่มทีั้งหมด 4 ชุด ใชสําหรับสรางแรงดัน Input เพื่อทดสอบการทํางานของวงจร A/D 
 

10K

+5V

V
O

L
n

 
 
การใชงานวงจร Push Button Switch 
 วงจร Push Button Switch จะใชวงจร Switch แบบ กดติด-ปลอยดับ (Push Button) พรอมวงจร 
Pull-Up ใชกับแหลงจาย +5V โดยในขณะที่สวิตชยงัไมถกูกดจะใหคาสถานะเปนโลจกิ “1” แตเมื่อสวิตชถูก
กดอยูจะใหสถานะเปนโลจกิ “0” โดยวงจรสวนนีจ้ะมีอยูดวยกนั 4 ชุด ใชสําหรับทดสอบการทํางานของ I/O 
ตางๆที่ตองควบคุมการทาํงานขอวงจรดวย Input แบบโลจิก 
 

Switch

10K

+5V

SW
n
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การใชงาน วงจรกําเนิดเสียง 
 วงจรกาํเนิดเสยีง จะใชลําโพงขนาดเล็ก (Mini Speaker) พรอมดวยวงจรทรานซสิเตอรแบบ NPN 
สําหรับขับกระแสใหกับลําโพง ใชกับแหลงจายขนาด +5V ทาํงานดวยโลจิก “1” และหยุดทํางานดวยโลจิก 
“0” โดยในการทาํงานนั้นตองสงสัญญาณโลจิกที่เปนความถี่ตางๆใหกับลําโพงเพือ่สรางเปนความถี่เสยีง
ยานตางๆ ตามตองการ 

+5V

1N
4148

B
C

547

1KM
IN

I SP
 

 
วงจรแหลงจายไฟ 
 วงจรแหลงจายไฟสามารถใชงานไดกับไฟ AC และ DC ขนาด 14-18V ไดทันท ี โดยวงจรภาค
แหลงจายไฟในสวนที่เปนวงจร Regulate นั้นจะมทีั้งสวนที่เปน +5V / 1A และ +13V/100mA โดยสวนที่
เปน +5V จะถูกใชสําหรับเปนแหลงจายไฟเพื่อจายใหกบั MCU และวงจร I/O ตางๆภายในบอรด สวน
แรงดัน +13V จะใชสําหรับเปนแรงดันสาํหรับการ Download โปรแกรม แบบ ICSP ของบอรด 
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การพัฒนาโปรแกรมของบอรด 
 สําหรับการพฒันาโปรแกรมของบอรด “ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP” นัน้ จะ
แบงออกเปน 2 สวนดวยกัน คือ สวนของการพัฒนาโปรแกรม และการ Download โปรแกรม โดยในสวน
ของการพฒันาโปรแกรมของบอรดนั้น จะเปนการเขียนโปรแกรมเพื่อควบคุมและสั่งงานให MCU สามารถ
ทํางานตามจดุประสงคที่ไดออกแบบไว ซึง่ในสวนนี้เปนหนาที่ของผูพฒันาโปรแกรม วาจะเลือกใชภาษาใด
ในการพัฒนาโปรแกรม รวมไปถึงการเลอืกใชโปรแกรมสําหรับทําหนาที่แปลคําสัง่ของภาษานัน้ๆ ใหเปน
รหัสคําสั่งในรูปแบบของ HEX File สําหรบัใช Download ใหกับหนวยความจําโปรแกรม (Flash Memory) 
ของ MCU เพือ่ส่ังงานให MCU ปฏิบัติตามคําสั่งในโปรแกรมที่ผูพฒันาโปรแกรมเขียนขึ้นมา 
 สําหรับสวนของการ Download โปรแกรม หรือการ Download HEX File ที่ไดจากการพัฒนา
โปรแกรมใหกบัหนวยความจําโปรแกรม (Flash Memory) ของ MCU นั้น จะตองอาศัยเครือ่งมือทาง
ฮารดแวรเปนสวนประกอบในการพัฒนาโปรแกรมดวย ซึง่ในกรณีของบอรด “ET-dsPIC30F2010” นั้น 
สามารถเลือกไดหลายแนวทาง ไมวาจะเปนการใชเครื่องมือสําหรับโปรแกรมขอมูลใหกับ MCU โดยใช
เครื่อง Programmer ที่สนบัสนุนการโปรแกรม MCU เบอร dsPIC30F2010 หรือใชชุดพัฒนาโปรแกรม
จําพวก In-Circuit Debugger ที่สนับสนุนการใชงานรวมกับ MCU เบอร dsPIC30F2010 ซึ่งทัง้ 2 แนวทาง
ขางตนที่กลาวมาแลวนั้น ทางผูใชจะตองเสียคาใชจายในการจัดหาเครื่องมือมาใชงานเอง แตอยางไรก็ตาม
ทางทมีงาน อีทีที ไดออกแบบวงจรของบอรด “ET-dsPIC30F2010” ใหสามารถทําการ Download Hex 
File จากคอมพิวเตอร PC โดยใชสัญญาณควบคุมจากพอรตขนาน หรือ พอรต Printer (LPT) โดยใชชุดสาย
ตอสัญญาณรุน “ET-CAB10PIN V2.0” เปนตัวกลางในการเชื่อมตอไดทันที โดยทีผู่ใชไมจําเปนตองจัดหา
เครื่องมืออ่ืนใดมาใชใหส้ินเปลืองอีก แตอยางไรก็ตามการพฒันาโปรแกรมของบอรดดวยวิธีการนี้ จะมี
ขอจํากัดอยู 2 ประการ เมื่อเทียบกับการใชชุด “In-Circuit Debugger” ในการพัฒนาโปรแกรม ก็คือ 

 ในปจจุบัน โปรแกรม MPLAB ยังไมยอมใหมีการเชือ่มตอเครื่องมือโปรแกรมอื่นๆที่ไมใช
เครื่องมือของ Microchips ผานทางเมนูคําสั่งของ MPLAB เอง ดังนัน้ผูใชจะตองแยกการ
ทํางานระหวางการพัฒนาโปรแกรม (เขียน Source โปรแกรม และ แปลเปน Hex File) 
และการ Download โปรแกรม (โปรแกรม Hex File ใหหนวยความจําของ MCU) 

 ไมสามารถตรวจสอบขอผิดพลาดของโปรแกรมในระหวางการสั่งให MCU ทํางานอยูได 
แตจะทําไดเพยีงการสั่งโปรแกรม (Download Hex File ให MCU) และ ดูผลการทํางาน
ของ MCU ในขณะที่ MCU ทํางานจริงๆ ซึ่งถาโปรแกรมที่เขียนขึ้นมาไมทาํงานหรือทํางาน
แลวเกิดความผิดพลาดขึ้น ผูใชจะตองใชความสามารถ ในการ คาดเดา และตรวจสอบหา
ขอผิดพลาดเหลานั้นจาก Source Code ของโปรแกรมเอง วานาจะมขีอผิดพลาดจากสวน
ใดของโปรแกรมบาง แลวจึงสั่งแกไขขอผิดพลาดนัน้ๆ พรอมกับส่ังแปลโปรแกรมซ้ําใหม 
แลวจึงสั่ง Download Hex File ให MCU ใหมเพื่อดูผลการทํางาน 
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การเขียนโปรแกรมใชงานกับบอรดโดยใช MPLAB C30 
 MPLAB C30 หรือ C30 Tools เปนโปรแกรมภาษาซ ีสําหรับใชแปลคําสั่งของ MCU ตระกูล dsPIC 
ซึ่งไดรับการพฒันาขึน้โดย Microchips เอง โดยขอกาํหนดและรายละเอียดของการเขียนโปรแกรมภาษาซี
นั้น จะไมกลาวถงึในทีน่ี้ดวย โดยถาผูใชตองการพฒันาโปรแกรมใหกับ dsPIC ดวยภาษาซ ี แตยังไมมี
ความรูเร่ืองการเขียนโปรแกรมภาษาซเีลยนั้นขอแนะนาํให หาหนงัสือที่อธิบายเกีย่วกับการเขียนโปรแกรม
ภาษาซีในสวนที่เปนมาตรฐานตามขอกําหนดของ “ANSI C” มาศึกษาใหเขาใจเสียกอน และสําหรับสวน
ของขอกําหนดปลีกยอยอื่นๆที่เปนของ MPLAB C30 เองก็สามารถอานเพิ่มเติมไดจากเอกสารและคูมือการ
ใชงานของ MPLAB C30 ที่ทาง Microchips จัดทําไวได โดยสามารถ Download จาก Website ของ 
Microchips หรือจาก Folder ของ “..\pic30_tools\docs” ที่ทาํการติดตั้งโปรแกรม MPLAB C30 ไวก็ได 
โดยในทีน่ี ้ จะขอกลาวแนะนําถงึเฉพาะสวนของการกาํหนดคาตวัเลือกในโปรแกรมเพื่อใชงานรวมกับบอรด 
“ET-dsPIC30F2010” เทานัน้ โดยในการที่จะใชงานโปรแกรม MPLAB C30 ในการเขียนโปรแกรมนั้น ผูใช
จําเปนตองทาํการติดตั้งโปรแกรมของ Microchips จํานวน 2 โปรแกรมดังนี้คือ 
 

 MPLAB IDE ซึ่งเปนโปรแกรม Text Editor ของ Microchips ซึ่งในปจจุบัน (ตุลาคม 2548) 
จะเปนรุน 7.21 แลวสามารถ Download มาใชงานไดฟรีจาก Web ของ Microchips 

 MPLAB C30 ซึ่งเปนตวัแปลภาษาซ ี (C Complier) ใหเปนรหัสคําสัง่ของ dsPIC โดยใน
ปจจุบัน(ตุลาคม 2548) จะเปน Version 1.33 ซึ่งตามปรกติแลวโปรแกรมชุดนี้จะตองซื้อ
มาใชงานเอง แตอยางไรกต็ามทาง Microchips เองมีรุนทดลองใชงานใหผูใชสามารถ 
Download มาใชงานไดเชนเดียวกนักับ MPLAB IDE 

 

โดยโปรแกรมทั้ง 2 ชุดนี ้ทางอีททีี ไดทาํการ Download มาจัดเตรียมไวใหในแผน CD-ROM ที่แถม
ไปกับบอรดของ “ET-dsPIC30F2010” ดวยอยูแลว โดยในการติดตัง้โปรแกรมนัน้ขอแนะนําใหผูใชทําการ
ติดตั้งโปรแกรมในชุดของ MPLAB IDE กอนเปนอนัดับแรก โดยขอแนะนาํใหติดตั้งโปรแกรมของ MPLAB 
IDE ไวตามคา Default ของโปรแกรมติดตั้งเลย คือ “C:\Program Files\Microchip\MPLAB IDE\" จะ
สะดวกตอการใชงานมากกวา ซึง่หลงัจากทําการติดตั้งโปรแกรม MPLAB IDE เสร็จเรียบรอยแลวในครั้งแรก
กอนการใชงานนัน้ตองสัง่ Restart เครื่องคอมพวิเตอรกอน หลังจากนัน้แลว MPLAB IDE จึงจะสามารถ
ทํางานไดโดยไมเกิดปญหา จากนั้นจงึทาํการติดตั้งโปรแกรม MPLAB C30 เปนลาํดับถัดไป โดยขอแนะนาํ
ใหทาํการติดตัง้โปรแกรมชุดนี้ไวตามคา Default ของการติดตั้งโปรแกรม คือ “C:\PIC30_TOOSL\” จะเกิด
ความสะดวกตอการใชงานมากที่สุด โดยเฉพาะในขัน้ตอนของการกาํหนดการเชื่อมโยงการทํางานระหวาง 
MPLAB IDE และ MPLAB C30 โดยในทีน่ี้จะขออธิบายโดยอางถงึตําแหนงการติดตั้งโปรแกรมดังที่กลาวไว
แลวขางตนเทานัน้ ซึ่งถาผูใชทําการสั่งติดตั้งโปรแกรมไวยังตําแหนง Folder ที่แตกตางไปจากนี้แลวขอใหทาํ
ความเขาใจและดัดแปลงวธิีการกาํหนดคาเองตามที่ติดตั้งโปรแกรมไวจริงๆดวย 
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การกําหนดการเชื่อมโยงการทํางานของ MPLAB IDE และ MPLAB C30 
 หลังจากทําการติดตั้งโปรแกรม MPLAB IDE และ MPLAB C30 เสร็จเรียบรอยแลว กอนที่จะ
เร่ิมตนใชงานโปรแกรม MPLAB C30 ไดนั้น ในครั้งแรกจะตองทาํการสั่งกาํหนดการเชื่อมโยงการทํางาน
ระหวาง MPLAB IDE และ MPLAB C30 ใหถูกตองเรียบรอยเสียกอน จงึจะสามารถเรียกใชงานโปรแกรม 
MPLAB C30 ผานทางโปรแกรม MPLAB IDE ไดอยางถกูตอง ทั้งนี้ก็เนื่องมาจากวา โปรแกรม MPLAB 
C30 นั้นจะเปนเพยีงตัวแปลคําสั่ง Text File ที่เปนภาษาซี (รวมทั้งภาษา Assembly) ใหเปนรหัสคําสั่งของ 
dsPIC ในรูปแบบของ Hex File เพียงอยางเดียวเทานัน้ สวนการเขียนโปรแกรม Source Code นั้นจะอาศัย
โปรแกรม MPLAB IDE เปนหลกั ซึ่งการสั่งแปลคําสั่งกจ็ะตองกระทําผานเมนูคําสัง่ของ MPLAB IDE ดวย 
เชนเดียวกนั ซึ่งตามปรกติแลว MPLAB IDE สามารถเชื่อมโยงการทาํงานรวมกับโปรแกรมอื่นๆไดอีกหลาย
โปรแกรม ไมไดใชงานเฉพาะกับ MPLAB C30 เพียงอยางเดียวเทานัน้ 
 โดยในชุดโปรแกรมของ MPLAB C30 หลงัจากติดตั้งโปรแกรมไปแลว โปรแกรม ใชงานตางๆจะถกู
เก็บไวใน Folder ชื่อ “C:\PIC30_TOOSL\BIN\” โดยจะมีโปรแกรมหลักๆที่ตองกําหนดการเชือ่มโยงการ
ทํางานกับ MPLAB IDE อยูดวยกนั 4 โปรแกรมดวยกันคือ 
 

 ไฟล “pic30-as.exe” ซึ่งเปนตวัโปรแกรมหลักสาํหรับใชในการสัง่งานในการแปลคําสั่ง
ภาษาแอสแซมบลี้ของ dsPIC (Assembler) 

 ไฟล “pic30-gcc.exe” ซึ่งเปนโปรแกรมหลักสาํหรับใชในการสั่งงานในการแปลคําสั่ง
ภาษาซีของ dsPIC (C Complier) 

 ไฟล “pic30-ld.exe” ซึ่งเปนโปรแกรมหลักสําหรับใชในการรวมไฟลตางๆเขาดวยกันเพื่อ
สรางเปน Hex File ของ dsPIC (Linker) 

 ไฟล “pic30-ar.exe” ซึ่งเปนโปรแกรมหลักในการจัดการกับ Library  
 

ซึ่งในอนัดับแรกกอนที่จะเริ่มตนเขาสูข้ันตอนของการใชงานนั้น จะตองทาํการกําหนดการเชื่อมโยง
คําสั่ง ระหวางโปรแกรม MPLAB IDE และ MPLAB C30 ใหเรียบรอยเสียกอน เพื่อทีโ่ปรแกรม MPLAB IDE 
จะไดทราบวาจะตองไปเรียกใชไฟลตางๆของ MPLAB C30 จากที่ใด โดยในการกาํหนดการเชื่อมโยง
โปรแกรมทั้ง 4 ใหสามารถใชงานกับ MPLAB IDE นั้นสามารถทําไดตามลําดับข้ันตอนตอไปนี ้

 
1. ส่ัง Run โปรแกรม MPLAB IDE โดยอาจเรียกจาก “ICON” ของโปรแกรมหรือเรียกผาน Windows 

จาก “Start → Program → PIC development Tools → Microchip MPLAB→ MPLAB”  
2. คลิกเมาสที่คําสั่ง “Project → Set Language Tools Locations..” แลวเลือกกาํหนดการใชงาน

โปรแกรม MPLAB IDE รวมกับโปรแกรม MPLAB C30 แลวเลือก “OK” ดังรูป 
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 เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่บริเวณตําแหนงเครื่องหมายบวก(+) ทีหนาคาํสั่งของ 
Microchip C30 Toolsuite (Supports 24F/30F/33F) ซึ่งจะไดผลดังรูป 
 

 
 
 ซึ่งจะเห็นไดวาในหัวขอ Microchip C30 Toolsuite (Supports 24F/30F/33F) นี้จะประกอบไปดวย
หัวขอยอยอกี 2 หัวขอ คือ Executables และ Default Search Patchs & Directories 

คลิกเมาสที่นี ่



คูมือการใชงานบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP 

ETT CO.,LTD -13- WWW.ETT.CO.TH 
 

 ใหทาํการกาํหนดตําแหนงของไฟลของ MPLAB C30 ทีต่องการให MPLAB IDE เรียกใช ซึง่จะมอียู
ดวยกนัทัง้หมด 4 ไฟล โดยใหคลิกเมาส ที่บริเวณตําแหนงเครื่องหมายบวก (+) ทีห่นาหวัขอ Executables 
ซึ่งจะไดผลดังรูป 
 

 
 

 ในขั้นตอนนี้ใหทาํการกําหนดชื่อ และ ตําแหนง Folder ที่อยูของไฟลทั้ง 4 ซึ่งไดแก pic30-ar.exe, 
pic30-as.exe, pic30-gcc.exe และ pic30-ld.exe โดยใหทาํการคลิกเมาสที่รายการยอยของแตละหัวขอ
จนปรากฏแถบสีน้ําเงินทีห่ัวขอนั้นๆจากนัน้ก็ใหกําหนดตําแหนง Folder และชื่อของไฟล ใหกับแตละหัวขอ
จนครบทัง้ 4 หัวขอ โดยชื่อไฟลนั้นตองกาํหนดตามชื่อที่อยูในวงเล็บทายหวัขอ สวนตําแหนง Folder นั้น
ตามปรกติแลวจะอยูที่ “..\pic30_tools\bin\” เชน ถาติดตั้งโปรแกรม MPLAB C30 ไวตามที่แนะนาํไวใน
ตัวอยางคือ “c:\pic30_tools\” ไฟลที่ใชส่ัง Run (Execute) ทั้งหมดจะอยูที่ “c:\pic30_tools\bin\..” 
 โดยวิธีการกําหนดชื่อและตาํแหนง Folder ที่อยูของไฟล นัน้สามารถทําได 2 แบบ คือ การสั่งคลิก
เมาสที ่ “Browse…” เพื่อกําหนดตําแหนงที่อยูของ Folder ซึ่งเกบ็ Execute File ไว โดยใหชี้ไปที ่
“..\pic30_tools\bin\..” ตัวอยางเชน ถาตองการกาํหนดชื่อ Execute File และตําแหนง Folder ของไฟล
สําหรับ LIB30 Archiver (pic30-ar.exe) ตองกําหนดชื่อไฟลเปน “pic30-ar.exe” โดยใหคลิกเมาสที่ 
“Browse…” แลวชี้ไปที่ “c:\pic30_tools\bin\pic30-ar.exe” หรืออาจใชวิธีการพิมพ ชื่อ Folder ในชอง 
Location เองเปน “c:\pic30_tools\bin\pic30-ar.exe” ก็ได (ถาติดตั้งโปรแกรมไวตางจากนี้ตองกาํหนดให
ตรงกับที่ติดตัง้ไวจริงดวย) 
 โดยในขั้นตอนนี้ ใหกําหนดชือ่และตําแหนง Folder ของ Execute File ใหครบทั้ง 4 หวัขอ ดวย ดัง
รูปในตัวอยางตอไปนี้ 

คลิกเมาสที่นี ่
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รูปแสดง ลักษณะการกาํหนด Execute File ของ LIB30 Archiver 
 
↓ 
 

 
 

รูปแสดง ลักษณะการกาํหนด Execute File ของ MPLAB ASM30 Assembler 
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รูปแสดง ลักษณะการกาํหนด Execute File ของ MPLAB C30 C Complier 
 
↓ 
 

 
 

รูปแสดง ลักษณะการกาํหนด Execute File ของ MPLAB LINK30 Object Linker 
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 เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่บริเวณตําแหนงเครื่องหมายบวก(+) ทีหนาคาํสั่งของ 
Default Search Patchs & Directories ซึ่งจะไดผลดังรูป 
 

 
 

เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่ “Assembler Include Search Path, $(AINDIR)” จน
ปรากฏแถบสีน้ําเงินดงัรูป แลวจึงคลิกเมาสที่ “Browse…” เพื่อกาํหนดตําแหนงที่อยูของ Folder ซึ่งเก็บ 
Source Code ภาษา Assembly ไว โดยใหชี้ไปที ่“..\pic30_tools\support\gld” หรืออาจใชวิธีการพิมพ ชื่อ 
Folder ในชอง Location เองก็ไดดังรูป (ถาติดตั้งโปรแกรมไวตางจากนีต้องกําหนดใหตรงดวย) 
 

 
 

คลิกเมาสที่นี ่
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เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่ “Include Search Path, $(INCDIR)” จนปรากฏแถบสีน้ํา
เงินดงัรูป แลวจึงคลิกเมาสที่ “Browse…” เพื่อกําหนดตําแหนงทีอ่ยูของ Folder ซึ่งเก็บ Header File ไว 
โดยในการกําหนดตําแหนง Folder นั้นใหชี้ไปที ่ “..\pic30_tools\support\h” หรืออาจใชวิธกีารพิมพ ชื่อ 
Folder ในชอง Location เองก็ไดดังรูป (ถาติดตั้งโปรแกรมไวตางจากนีต้องกําหนดใหตรงดวย) 
 

 
 

เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่ “Library Search Path, $(LIBDIR)” จนปรากฏแถบสีน้าํ
เงินดงัรูป แลวจึงคลิกเมาสที ่“Browse…” เพื่อกําหนดตําแหนงที่อยูของ Folder ซึ่งเก็บ Library File ไว โดย
ในการกาํหนดตําแหนง Folder นัน้ใหชี้ไปที่ “..\pic30_tools\lib” หรืออาจใชวิธกีารพิมพ ชื่อ Folder ในชอง 
Location เองก็ไดดังรูป (ถาติดตั้งโปรแกรมไวตางจากนีต้องกําหนดใหตรงดวย) 
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ตัวอยางการสรางโปรแกรมภาษาซีของ MPLAB C30 
เมื่อทําการกาํหนดการเชื่อมโยงคําสัง่ระหวาง MPLAB IDE และ MPLAB C30 เปนที่เรียบรอยแลว 

ตอจากนี้ไป ผูใชก็สามารถทาํการเรียกใชงานโปรแกรม MPLAB C30 ผานทางโปรแกรม MPLAB IDE ได
แลว โดยคาตัวเลือกตางๆที่ไดกําหนดไวแลวนั้นจะถกูเก็บไวใน Configuration ของโปรแกรมตลอดไป 
จนกวาจะมีการสั่งเปลี่ยนแปลงใหม ซึ่งในที่นี้จะขอยกตวัอยางการเขียนโปรแกรมภาษาซี ของ MPLAB C30 
สัก 1 ตัวอยางพอเปนแนวทางใหผูใชทาํความเขาใจ โดยมีลําดับข้ันตอนดังนี ้

1. ส่ัง Run Program ของ MPLAB IDE ข้ึนมา จากนัน้ก็ส่ังสรางไฟลใหมข้ึนมา 1 ไฟล สําหรับเขียน 
Source Code ภาษาซี โดยใชคําสั่ง “File → New” จากนัน้ใหทําการพิมพ Source Code ภาษาซี
ใน Work Sheet ของโปรแกรม MPLAB IDE ดังตัวอยาง 

 

 
 
 
2. ทําการสั่งบนัทึกไฟลที่เขียนขึ้นใหเปน Text File ภาษาซี โดยใหทดลองกําหนดชื่อเปน “main.c” 

แลวสั่งบันทึกไวใน Folder ชื่อ “c:\pic30_tools\examples\demo1\main.c” โดยในทีน่ี้ใหใชคําสั่ง 
“File → Save As…” แลวสราง Folder ชื่อ demo1 ไวภายใต Folder ของ examples อีกชั้นหนึ่ง 
แลว กาํหนดชือ่เปน “main.c” แลวเลือก “Save” ดังรูป 



คูมือการใชงานบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP 

ETT CO.,LTD -19- WWW.ETT.CO.TH 
 

 
 

 ซึ่งจะเห็นวาเมือ่ทําการสั่งบนัทึกไฟลเปน “main.c” ไปแลว กลุมของตวัอักษรตางๆทีไ่ดพิมพไว จะ
ถูกจัดแบงกลุม โดยใชสีในการแสดงผลทีแ่ตกตางกนัไปตามหนาที่ของกลุมตัวอกัษร เชน กลุมตัวอักษรที่ใช
เปนคําอธิบาย (Comment) กลุมตัวอักษรที่เปนคาํสั่ง และกลุมตัวอักษรที่เปนตัวแปรตางๆ ซึง่จดุนี้เปนขอดี
ของ MPLAB IDE ที่สามารถแยกการแสดงผลกลุมตัวอักษรตามหนาทีก่ารใชงานได ทําใหเราสามารถอาน
โปรแกรมไดงายและสะดวกมากยิง่ขึ้นดงัรูป 
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#include <p30f2010.h>             // dsPIC30F2010 MPU Register 
 
_FOSC(CSW_FSCM_ON & XT_PLL16);  // Enable Clock Switching 
        // Enable Fail-Self Clock 
        //   Clock Source = Primary XT  
        // Enable PLL x 16 
_FWDT(WDT_OFF);    // Disable Watchdog  
_FBORPOR(PBOR_ON & BORV_45 &   // Enable Brown-Out = 4.5V 
      PWRT_64 &     // Power ON = 64mS          
      MCLR_EN);    // Enable MCLR    
_FGS(CODE_PROT_OFF);   // Code Protect OFF 
 
void delay_led(unsigned long int); // Delay Time Function 
 
int main(void) 
{   
  TRISBbits.TRISB0 = 0;   // Config RB0 = Output 
   
  while(1)      //  Loop Continue 
  { 
    LATBbits.LATB0 = !LATBbits.LATB0;  // Toggle Output RB0  
 delay_led(1000000);      // Display LED Delay 
  }    
}    
 
void delay_led(unsigned long int count1) 
{ 
  while(count1 > 0) {count1--;}  // Loop Decrease Counter  
} 

 
แสดง ตัวอยาง Source Code สําหรับใชทดลองการทํางาน 

 
 สําหรับตัวอยางนี้จะเปนการสั่งใหใชพอรต RB0 ทําหนาที่เปน Output ขับ LED ใหติดและดับ
สลับกันไปไมรูจบในลักษณะของไฟกระพรบิ ซึ่งวิธีการทดสอบการทาํงานของโปรแกรมนี้ โดยใชกับบอรด 
ET-dsPIC30F2010 นั้นทําไดโดยตอสัญญาณจาก RB0 เขากับ LED Output ของบอรด โดยจะเห็นผลการ
ทํางานของโปรแกรมแกรม คือ LED จะกระพริบ ติดและดับอยางตอเนื่องตลอดเวลา 
 สวนที่นาสนในของโปรแกรมคือบรรทัดคําสั่ง “_FOSC(CSW_FSCM_ON & XT_PLL16);” ของ
โปรแกรมไปจนถึงบรรทัดคําสั่ง “_FGS(CODE_PROT_OFF);” โดยในสวนนี้เปนสวนของการกําหนดคา 
Configuration ของ MCU เบอร “dsPIC30F2010” เพื่อใชกับบอรด “ET-dsPIC30F2010”  
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3. ทําการสราง Project File เพื่อใชส่ังผนวกไฟลตางๆ ที่เกี่ยวของเขาดวยกนั ทั้งนี้เนื่องมาจากวา
ภาษาซีของ MPLAB C30 นั้น ถูกออกแบบใหมีความออนตัวในการใชงาน ดังนั้นจึงมีการจัดสราง
และแบงแยกไฟลออกเปนหลายๆไฟลตามหนาที่การใชงาน เพื่อใหผูใชสามารถเรียกไฟลตางๆ
เหลานั้นเขามาใชงานรวมกบั Source Code  ที่เขยีนขึ้นมาไดไดงาย โดยไมตองเสียเวลาเขยีน 
Source Code เองทั้งหมด ซึ่งจะทาํใหผูใชสามารถลดเวลาในการเขียนโปรแกรมไปไดเปนอยาง
มากเนื่องจากเพียงแตทําการสั่งผนวกไฟลที่ทาง MPLAB C30 สรางเตรียมไวให เขากับ Source 
Code ที่ผูใชเขียนขึ้นใหมแลวสั่งแปลโปรแกรมก็จะไดไฟลที่มีความสมบูรณตอการใชงานแลว โดย
จากตัวอยาง Source Code ที่ไดทดลองเขียนไปแลวในขางตน ก็เชนเดียวกัน จะเห็นไดวามีการสั่ง
ผนวกไฟลชื่อ “p30f2010.h” เขามาใชงานดวย ซึง่ทาํใหไมตองเสียเวลาไปสัง่ประกาศชื่อและ
ตําแหนงรีจิสเตอรตางๆของ dsPIC30F2010 ใหเสียเวลา แตสามารถอางถึงชื่อของรีจิสเตอรตางๆ
ในโปรแกรมไดทันที โดยวิธกีารกําหนดคุณสมบัติของ Project File มีดังนี ้

 ส่ังกําหนดคุณสมบัติของ project File โดยใชคําสั่ง “Project → Project Wizard…” ซึง่
จะไดผลดังรูป จากนัน้ใหเลอืก “Next >” เพื่อไปยังขั้นตอนตอไป 

 

  
 
 หลังจากเลือก “Next >” แลว โปรแกรมจะรอใหกาํหนดเบอรของ MCU ที่จะใชงานรวมกบั
โปรแกรมที่เขยีนขึ้น ซึ่งใหเลือกกําหนดเปน “dsPIC30F2010” จากนั้นเลือก “Next >” เพื่อขามไปทํางานยงั
ข้ันตอนตอไปดังรูป 
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 ในขั้นตอนนี้จะเปนการเลือกวาจะใชโปรแกรมชุดใดในการแปลคําสั่ง เนื่องจาก MPLAB IDE 
สามารถใชงานไดกับชุดโปรแกรมตางๆมากมายหลายโปรแกรม ซึ่งในทีน่ี้ใหเลือกกาํหนดใชโปรแกรม ของ 
MPLAB C30 โดยการเลือกกําหนดตัวเลือกของ “Active Toolsuite” ใหเปนของ MPLAB C30 โดยกําหนด
ตัวเลือกเปน “Microchip C30 Toolsuite (Supports 24F/30F/33F)” ดังรูป แลวเลือก “Next >” 
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ในขั้นตอนนี้จะเปนการ กาํหนดชื่อ Project และตําแหนง Folder ที่จะใชเก็บไฟลตางๆที่ไดจากการ
ทํางานของ Project โดยใหกาํหนดชื่อเปน “LED_BLINK” แลวกาํหนดตําแหนง Folder เปน DEMO1 โดย
กําหนดไวภายใต Folder ชื่อ examples ของ MPLAB C30 ดังรูป แลวเลือก “Next >” 

 

 
 

 ในขั้นตอนนี้จะเปนการสั่งผนวกไฟลตางๆเขาไวดวยกนัภายใตชื่อ Project ของ LED_BLINK โดย
ใหทาํการสัง่ผนวกไฟลทัง้หมด 3 ไฟลเขาไวใน Project ดังนี ้

 ส่ังผนวกไฟลชือ่ “main.c” ซึ่งเปน Source Code ที่เราไดเขียนและสั่งบันทึกไวแลวใน
ข้ันตอนที่ผานมาโดยเก็บอยูใน c:\pic0_tools\examples\demo1\main.c” 

 ส่ังผนวกไฟลชือ่ “libp30f2010a2.a” ซึ่งเปน Library ที่ใชกับ MCU เบอร dsPIC30F2010 
ซึ่งทาง MPLAB C30 ไดจัดสรางเตรียมไวใหใชงาน โดยถาติดตั้งโปรแกรมตามตัวอยาง
ไฟลดังกลาวจะเก็บอยูใน “c:\pic30_tools\lib\libp30f2010a2.a” 

 ส่ังผนวกไฟลชือ่ “p30f2010a2.gld” ซึ่งเปน Script File ของ dsPIC30F2010 ที่ทาง 
MPLAB C30 สรางเตรียมไวให โดยถาตดิตั้งโปรแกรมตามตัวอยางไฟลดังกลาวจะเก็บอยู
ใน “c:\pic30_tools\support\gld\p30f2010a2.gld” 

 
โดยในการสั่งผนวกไฟลทัง้ 3 ดังกลาวใหทาํการคลิกเมาสไปยงั “ICON” ของไฟลจากตาํแหนง 

Folder ที่กลาวไวในขางตนที่ผานมาแลวเลือก “Add >>” จนชื่อไฟลดังกลาวไปปรากฏอยูทีก่รอบหนาตาง
ดานขวาของโปรแกรม ซึ่งใหเลือกทําตามวิธีการนี้จนสามารถสั่ง “Add” ไฟลไดครบทั้ง 3 ไฟล แลวเลือก 
“Next >” เพื่อไปยังขั้นตอนตอไปดังรูป 
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 เมื่อส่ังผนวกไฟลทัง้หมดเขากับ Project ไฟลที่สรางขึ้นเปนที่เรียบรอยแลว โปรแกรมจะรายงานผล 
โดยแสดงคาพารามิเตอรตางๆที่ไดกําหนดไวแลวใหทราบดังรูป ใหเลือก “Finish” เปนอันเสร็จข้ันตอนของ
การสราง Project File ของ BLINK_LED  
 

 
 
 

 ซึ่งหลงัจากกาํหนดคาตางๆใหกับ Project File เปนที่เรียบรอยแลว ผูใชก็สามารถทําการสั่งแปล
คําสั่งของโปรแกรม “main.c” ที่เขียนขึ้นไดทันที โดยใชคําสั่ง “Project → Build All” ซึ่งจะทําใหไดไฟล 
Output มีชื่อเดียวกับ Project File ที่สรางไวแตมีนามสกุลเปน HEX ซึ่งจากตัวอยาง Project นี้เมื่อส่ังแปล
โปรแกรมแลวถาไมเกิดขอผิดพลาดใดๆจะได Output ไฟลชื่อ “LED_BLINK.HEX” โดยไฟลดังกลาวจะถูก
สรางและเก็บไวในตําแหนง Folder ของ Project คือ  “c:\pic30_tols\examples\demo1\led_blink.hex” 
โดยผูใชสามารถสั่ง Download Hex File ชื่อ “LED_BLINK.HEX” นี้ใหกับบอรด “ET-dsPIC30F2010” เพื่อ
ทดสอบการทาํงานไดทนัท ี 
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การ Download HEX File ใหบอรดดวยโปรแกรม “WinPic800” 
 

 การ Download Hex File ใหกับบอรดนั้น ในปจจบัุน (พฤศจิกายน 2548) สามารถเลือกใช
โปรแกรม “WinPic800” หรือ “melabs Programmer” ก็ไดตามตองการ โดยไมวาจะเลือกใชโปรแกรมชุดใด 
เปนโปรแกรมสั่ง  Download ก็สามารถใชงานไดเหมือนกนัทุกประการ เพียงแตวธิีการสั่งงานโปรแกรมอาจ
มีรายละเอยีดและหนาตาของโปรแกรมทีแ่ตกตางกนัไปบาง แตไมวาจะเลือกใชโปรแกรมชุดใดในการ
ส่ังงานก็ตามจาํเปนจะตองใชชุด “ET-CAP10PIN V2.0” เปนตัวกลางในการเชื่อมตอสัญญาณจากพอรต
ขนาน (LPT) ของคอมพิวเตอร PC กับบอรด โดยในการ Download นั้นจะตองใช Adapter จายไฟใหกับ
บอรดดวยคาแรงดันไมตํ่ากวา 14V ไมเชนนัน้แลวจะไมสามารถสั่ง Download HEX File ใหกับ MCU ได  

สําหรับโปรแกรม “WinPic800” นั้น เปนโปรแกรมประเภท “Free Ware” ใชสําหรบั Download 
Hex File ใหกบั MCU ตระกูล PIC และ dsPIC พัฒนาข้ึนโดย “Sisco Benach Font” ซึ่งทางอทีีท ีไดรวม
สนับสนนุคาใชจายใหกับทางผูพัฒนาโปรแกรม เพื่อขอสิทธิ์ในการนําโปรแกรมดงักลาวมาแจกจายเพื่อใช
งานกับสินคาของทางอีททีดีวยแลว ซึ่งผูใชสามารถทําการ Download มาใชงานไดฟรีโดยไมเสียคาใชจาย
ใดๆ โดยโปรแกรมตัวนี้ในปจจุบันไดรับการปรับปรุงมาอยางตอเนื่องเปนลาํดับจนถึงรุนลาสุดคือ “3.56” 
แลว ซึ่งในรุนนี้สามารถใชงานไดกับ MCU ตระกูล PIC และ dsPIC ของ Microchips ไดมากมายหลาย
เบอรรวมทัง้เบอร “dsPIC30F2010” ดวย โดยขั้นตอนของการ Download HEX File ดวยโปรแกรม 
“WinPic800” มีลําดับข้ันตอนเปนดงันี ้

1. ติดตั้งโปรแกรม “WinPic800” ในเครื่องคอมพิวเตอรใหเรียบรอยพรอมใชงาน 
2. เขียนโปรแกรมและแปลคําสั่งของโปรแกรมที่เขียนใหเปน “Hex File” ซึ่งวิธกีารเขียนโปรแกรมและ

การสั่งแปลโปรแกรมจะไมขอกลาวถึงในทีน่ี้ดวย ทัง้นี้ข้ึนอยูกับผูใชวาจะเลือกใชภาษาอะไรในการ
พัฒนาโปรแกรม และจะเลอืกใชโปรแกรม Assembler หรือ Complier ตัวใดเปนตัวแปลคําสั่งให
แตทายที่สุดแลวไมวาจะเขยีนโปรแกรมดวยภาษาอะไร หรือ ใชโปรแกรมใด เปนตวัแปลคําสั่งกจ็ะ
ไดไฟล Output ที่จะนํามาใชในการสัง่งาน MCU เหมอืนๆกันในรูปแบบของ “Hex File” ซึ่งในที่นี้
จะขอกลาวถึงเพียงวิธกีารสัง่ Download Hex File ใหกบัหนวยความจํา Flash ของ MCU ภายใน
บอรด “ET-dsPIC30F2010” เทานัน้ สวนวิธีการซึ่งจะทาํใหได Hex File มานั้นจะไมขอกลาวถงึ 

3. ติดตั้งชุด “ET-CAP10PIN V2.0” เขากับพอรตขนาน (LPT Port หรือ Printer Port) ของเครื่อง
คอมพิวเตอร PC เพื่อใชในการสั่ง Download Hex File ดวยโปรแกรม “WinPIc800” 

4. ตอสายแพรขนาด 10 PIN จากขั้วตอ “ET-EMPIC” ของบอรด “ET-CAP10PIN V2.0” เขากับข้ัวตอ
สําหรับ Download ของบอรด “ET-dsPIC30F2010” ที่ตําแหนง “DOWNLOAD(ET-EMPIC)” 

5. เลือกสวิตชสําหรับเลือกโหมดการทํางานของบอรด (RUN/PROG) ใหอยูในโหมด Program โดยให
เลือกสวิตชไวทางดาน “PROG” 
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6. ทําการจายไฟใหกับบอรด “ET-dsPIC30F2010” ซึ่งจะตองใชแหลงจายไฟซึง่มีคาแรงดันไมนอย
กวา 14V ดวยถาแหลงจายไฟมีคาแรงดนัต่ํากวานี้จะไมสามารถสัง่โปรแกรมไดสําเร็จ 

7. ส่ัง Run Program ของ “WinPIC800” เพือ่เร่ิมตนขั้นตอนของการ Download HEX File 
 

 
 

รูปแสดง ลักษณะของโปรแกรม “WinPic800” 
 

8. ถายงัไมไดกําหนดคาตวัเลือกใหกับโปรแกรม “WinPic800” เพื่อใชส่ัง Download Hex File ใหกบั
MCU เบอร “dsPIC30F2010” รวมกับระบบฮารดแวรของ อีทีท ี มากอน ใหทาํการกาํหนดคา
ตัวเลือกของโปรแกรมสําหรบัใชงานรวมกบั MCU ตระกูล dsPIC ใหเรียบรอยดังนี ้

 กําหนดภาษาที่จะใชในการสั่งงานโปรแกรม โดยขอแนะนําใหเลือกเปนภาษาอังกฤษ โดย
ใหคลิกเมาสทีเ่มนูคําสัง่ Language แลวเลอืก English ดังรูป 
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 ทําการกําหนดรูปแบบการเชื่อมตอทางฮารดแวรของบอรดใหถูกตอง โดยการคลิกเมาสที่
เมนูคําสัง่ “Settings → Hardware” โดยในกรณีที่ใชงานโปรแกรม “WinPIC800” รวมกับ
บอรด “ET-dsPIC30F2010” โดยใชสาย Download ของ อีททีี รุน “ET-CAP10PIN V2.0” 
ใหกําหนดรูปแบบการเชื่อมตอทางฮารดแวรเปน “ETT ET-dsPIC30F2010” หรืออาจเลือก
เปน “ETT-HIGH VPP ICSP” ก็ไดตามตองการ สวน LPT นัน้ใหกาํหนดตามความเปนจริง 
ซึ่งปรกติจะเปน “LPT1” แลวเลือก “Apply edits” ดังรูป 

 

 
 

 ทําการกําหนดเงื่อนไขการทํางานของโปรแกรมวาตองการใหโปรแกรมทํางานตามลําดับ
ข้ันตอนอยางไรบาง โดยการคลิกเมาสที่เมนูคําสั่ง “Settings → Software” ดังรูป 

 
ที่ Tab ของ Program ใหเลือก 

 Verify after programming 
 

ที่ Tab ของ Device ใหเลอืก 
 Use user device selection 
 Detect and  select device at startup 

 
ที่ Tab ของ Hex ใหเลือก 

 Update File before programming 
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 ↓ 

 
↓ 

 
 

 ซึ่งในขัน้ตอนนี้อาจเลือกทกุขั้นตอนเลย แตถาเหน็วาเลอืกทุกขัน้ตอนแลวทําใหเสียเวลาใน
การ Download นานเกินไปก็อาจลดหวัขอที่ไมจําเปน เชน Verify after programming ออกก็ได
จากนั้นใหเลือกที่ “Accept” เพื่อบันทึกคาตัวเลือกนี้ไวใชงานกับโปรแกรมตลอดไป 
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9. หลังจากทําการกําหนดคาตวัเลือกตางๆใหกับโปรแกรมเปนทีเ่รียบรอยแลว หลงัจากนีเ้ปนตนไปก็
สามารถสัง่งานโปรแกรม “WinPic800” ไดตามตองการ โดยคาตัวเลอืกที่กาํหนดไวจะถกูบันทึกไว
เพื่อใชเปนเงื่อนไขในการทํางานของโปรแกรมตลอดไปจนกวาจะมีการสั่งเปลี่ยนแปลงใหม ซึ่งนัน่ก็
หมายความวาในครั้งตอๆไปถาตองการใชงานโปรแกรมรวมกับบอรด “ET-dsPIC30F2010” อีกก็
จะไมจําเปนตองเขาไปกําหนดคาตัวเลือกในโปรแกรมใหมใหเสียเวลาอีก สามารถขามขั้นตอนของ
การกําหนดคาตัวเลือก (ขอ 8) ไปส่ังงานโปรแกรมไดทันทีเลย โดยวิธีการสําหรับส่ังงานโปรแกรม 
“WinPic800” นั้นสามารถทาํได 2 วิธ ี คือการสั่งงานผานทาง เมนูคําสั่ง หรือส่ังงานผาน “Button” 
คําสั่งตางๆ ของโปรแกรมไดตามตองการ ดังตัวอยาง 

 ส่ัง Open Hex File เพื่อใชในการ Download ใหกับ MCU โดยสามารถสั่งผานเมนคํูาสั่ง
ของ “File → Open” หรือคลิกเมาสที ่Button คําสั่ง  แลวเลือกกําหนดชื่อและที่อยู
ของ Hex File ที่ตองการจะใช Download ตามตองการ 

 ส่ังตรวจสอบการเชื่อมตอทางฮารดแวรกับ MCU โดยสามารถสั่งงานผานเมนูคําสั่งของ 
“Device Detect PIC” หรือคลิกเมาสที่ Button คําสั่ง  ซึ่งโปรแกรมจะทาํการอาน
รหัส ID Code ของ MCU พรอมกับแสดงชื่อเบอรของ MCU ที่ตรวจพบใหทราบ โดยถา
การทาํงานถูกตองในกรณีทีใ่ชกับบอรด “ET-dsPIC30F2010” จะตองไดผลดังรูป 

 

 
 

 ถาการตรวจสอบเบอร MCU เกิดความผดิพลาด โดยถาโปรแกรมแสดงเบอรไมถูกตอง ให
ลองตรวจสอบตําแหนงสวิตชเลือกการทํางาน “PROG/RUN” วาถูกเลือกไวทางดาน “PROG” 
ถูกตองแลวหรอืยัง สายสัญญาณตางๆตอ แนน สนทิ ดีหรือยัง คาแรงดันของแหลงจายไฟที่ใช
มีคาถูกตองหรือไม (14V-18V) รวมทั้งการกาํหนดรูปแบบการเชื่อมตอทางฮารดแวรของ
โปรแกรมกําหนดไวเปน “ETT-HIGH VPP ICSP” หรือ “ETT ET-dsPIC30F2010” ถูกตอง
หรือไม ถาทุกอยางเรยีบรอยแลวลองทําซ้าํดูอีกครั้งหนึ่งจนไดคาเบอร MCU ที่ถูกตอง 
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 ตรวจสอบคา Configuration ของ “dsPIC30F2010” วากาํหนดไวถกูตองหรือไม โดยใน
กรณีที่ใชงานกับบอรด “ET-dsPIC30F2010” นั้นตองกําหนดคา Configuration ของ 
MCU ในสวนของการเลือกกําหนดคาความถี่ของสัญญาณนาฬิกา และการทาํงานของ
วงจร Watchdog ดวยคาตวัเลือกดังนี ้ 

 OSC Source on POR ใหเลือกกําหนดเปน Primary ซึ่งเปนการเลือกกําหนดให 
MCU เลือกใชสัญญาณนาฬกิาจากวงจร Primary Clock Source 

 Primary Oscillator ใหเลือกเปน XT w/PLL 16X - XT crystal oscillator mode 
with 16X PLL ซึ่งเปนการเลือกสัญญาณนาฬิกาของ Primary Clock Source 
จากตัวกําเนิดความถี ่ XTAL คา 4-10MHz ภายนอกซึ่งตอไวที่ขา OSC1,OSC2 
พรอมกับเปดการทาํงานของวงจรคูณความถี่ไวที ่16 เทาของความถี ่XTAL ดวย 

 FWDTEN ตองไมเลือกเพื่อเปนการสัง่ปดการทาํงานของ Watchdog 
สวนคา Configuration อ่ืนๆ สามารถเลอืกกําหนดไดเองตามตองการ ซึ่งตามปรกติ

แลวคาของ Configuration นี้จะถกูกาํหนดคาไวในขั้นตอนของการพฒันาโปรแกรมอยูแลว
โดยเมื่อส่ังแปลโปรแกรมเปน HEX นั้นคา Configuration จะฝงอยูใน HEX File ดวยเสมอ
แตอยางไรก็ตามถาผูใชไมไดกําหนดคาทีถู่กตองใหกับ Configuration ไวดวย ในขั้นตอน
ของการพฒันาโปรแกรมก็อาจทาํใหคา Configuration มีคาไมถูกตองตามตองการ ดังนัน้
จะตองแกไขคาตัวเลือกของ Configuration ใหถูกตองกอนสั่ง Program โดยผูใชสามารถ
ตรวจสอบคาของ Configuration ในปจจุบันไดจากหนาจอโปรแกรม โดยการคลิกเมาส
เลือกไปที่แท็ปของ “Setting” ดังรูป 

 

 
 

รูปแสดงการกาํหนดคา Configuration สําหรับบอรด “ET-dsPIC30F2010” 
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 ส่ัง Download Hex File ใหกับหนวยความจํา Flash ของ MCU ในบอรด โดยสามารสัง่
ผานเมนูคําสัง่ของ “Device → Program All”  หรือคลิกเมาสที ่Button คําสั่ง  ซึ่ง
หลังจากขั้นตอนนี้เสร็จส้ินลง ถาไมเกิดความผิดพลาดใดๆ เมื่อเลือกสวิตชกาํหนดโหมด
การทาํงานของบอรดไปยังดาน “RUN” จะเห็นวา MCU จะเริ่มตนทํางานทันท ี

 

 
↓ 

 
↓ 

 
 

รูปแสดง ลําดับขั้นการทาํงานของการสั่งงานดวยคําสั่ง “Program All” 
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การ Download HEX File ใหบอรดดวยโปรแกรม “melabs Programmer” 
 

 สําหรับโปรแกรม “melabs Programmer” ก็เปนอกีโปรแกรมหนึง่ซึง่สามารถนํามาใชงานในการสัง่ 
Download Hex File ใหกับ MCU ของบอรด “ET-dsPIC30F2010” ไดดีเชนเดียวกนักับ “WinPic800” โดย
โปรแกรม “melbas Programmer” เปนของ “micro Engineering Labs, Inc.” ซึ่งเปนผูพัฒนาโปรแกรม 
PIC Basic Pro Complier สําหรับ MCU ตระกูล PIC ที่หลายคนรูจกักันเปนอยางนี้มาแลว โดยโปรแกรม 
“melbas Programmer” รุน Beta สามารถ Download มาใชไดฟรีโดยไมเสียคาใชจายเชนเดียวกัน สําหรับ
วิธีการใชงานโปรแกรม “melbas Programmer” รวมกับบอรด “ET-dsPIC30F2010” มีดังตอไปนี ้
 

1. ติดตั้งโปรแกรม “melbas Programmer” ในเครื่องคอมพวิเตอรใหเรียบรอยพรอมใชงาน 
2. เขียนโปรแกรมและแปลคําสั่งของโปรแกรมที่เขียนใหเปน “Hex File” ซึ่งวิธกีารเขียนโปรแกรมและ

การสั่งแปลโปรแกรมจะไมขอกลาวถึงในทีน่ี้ดวย ทัง้นี้ข้ึนอยูกับผูใชวาจะเลือกใชภาษาอะไรในการ
พัฒนาโปรแกรม และจะเลอืกใชโปรแกรม Assembler หรือ Complier ตัวใดเปนตัวแปลคําสั่งให
แตทายที่สุดแลวไมวาจะเขยีนโปรแกรมดวยภาษาอะไร หรือ ใชโปรแกรมใด เปนตวัแปลคําสั่งกจ็ะ
ไดไฟล Output ที่จะนํามาใชในการสัง่งาน MCU เหมอืนๆกันในรูปแบบของ “Hex File” ซึ่งในที่นี้
จะขอกลาวถึงเพียงวิธกีารสัง่ Download Hex File ใหกบัหนวยความจํา Flash ของ MCU ภายใน
บอรด “ET-dsPIC30F2010” เทานัน้ สวนวิธีการซึ่งจะทาํใหได Hex File มานั้นจะไมขอกลาวถงึ 

3. ติดตั้งชุด “ET-CAP10PIN V2.0” เขากับพอรตขนาน (LPT Port หรือ Printer Port) ของเครื่อง
คอมพิวเตอร PC เพื่อใชในการสั่ง Download Hex File ดวยโปรแกรม “melbas Programmer” 

4. ตอสายแพรขนาด 10 PIN จากขั้วตอ “ET-EMPIC” ของบอรด “ET-CAP10PIN V2.0” เขากับข้ัวตอ
สําหรับ Download ของบอรด “ET-dsPIC30F2010” ที่ตําแหนง “DOWNLOAD(ET-EMPIC)” 

5. เลือกสวิตชสําหรับเลือกโหมดการทํางานของบอรด (RUN/PROG) ใหอยูในโหมด Program โดยให
เลือกสวิตชไวทางดาน “PROG” 

6. ทําการจายไฟใหกับบอรด “ET-dsPIC30F2010” ซึ่งจะตองใชแหลงจายไฟซึง่มีคาแรงดันไมนอย
กวา 14V ดวยถาแหลงจายไฟมีคาแรงดนัต่ํากวานี้จะไมสามารถสัง่โปรแกรมไดสําเร็จ 

7. ส่ัง Run Program ของ “melabs Programmer” เพื่อเร่ิมตนขั้นตอนของการ Download HEX File 
ซึงจะไดผลดังรูป 

 

 
 

รูปแสดง ลักษณะของโปรแกรม “melabs Programmer” 
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8. ถายงัไมไดกําหนดคาตวัเลือกใหกับโปรแกรม “melabs Programmer” เพื่อใชส่ัง Download Hex 
File ใหกับ MCU เบอร “dsPIC30F2010” รวมกับระบบฮารดแวรของ อีททีี มากอน ใหทําการ
กําหนดคาตัวเลือกของโปรแกรมสําหรับใชงานรวมกบั MCU ตระกูล dsPIC ใหเรียบรอยดังนี ้

 กําหนดการทาํงานของคาํสัง่ โดยใหเลือกเมาสทีเ่มนูคําสั่ง “Options” แลวเลือกคลิกเมาส
หนาตัวเลือกคาํสั่งตางๆจนปรากฏเครื่องหมาย (√) หนาคําสั่งดังนี ้

 Update Configuration From File เปนการกําหนดใหโปรแกรมทําการ
เปลี่ยนแปลงคาตัวเลือกของ Configuration ตามคาที่กาํหนดไวจาก Hex File 
ที่ส่ัง Open มาใชงานในโปรแกรม 

 Erase Before Programming เปนการสัง่ใหโปรแกรมทําการสั่งลบขอมูลจาก
หนวยความจาํของ MCU กอนสั่งโปรแกรมโดยอัตโนมัติ ซึ่งจะทําใหเราไมตอง
เสียเวลาไปสั่งลบขอมูลดวยคําสั่ง Erase เองใหเสียเวลา 

 Verify After Programming เปนการสัง่ใหโปรแกรมทําการสั่ง Verify หรือ
ตรวจสอบความถูกตองของขอมูลดวยหลงัจากโปรแกรมเสร็จแลว 

 

 
 

  ทาํการสัง่กําหนดคาตวัเลือกพิเศษเพิ่มเตมิใหกับโปรแกรมอีก โดยใหทาํการคลิกเมาสที่
คําสั่ง “Options → More Options” แลวเลือกกาํหนดคาตางๆดังนี ้

 ใหคลิกเมาสหนาตัวเลือกของคําสั่ง “Verify Device Target ID” จนปรากฏ
เครื่องหมาย (√) หนาคําสั่ง เพื่อเปนการสัง่ใหโปรแกรมตรวจสอบความ
ถูกตองของเบอร MCU วาตรงตามทีเ่ลือกไวหรือไม 

 ใหเลือกการทาํงานของคาํสัง่ Program โดยใหเลือกกําหนดขัน้ตอนการ
ทํางานของคําสั่งดังนี ้ (Options → More Options → Program) 

• Code 
• Data 
• Configuration 
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 ใหเลือกการทาํงานของคาํสัง่ Verify โดยใหเลือกกําหนดขั้นตอนการทํางาน
ของคําสั่งดังนี ้(Options → More Options → Verify) 

• Code 
• Data 
• Configuration 
 

 ใหเลือกการทาํงานของคาํสัง่ Read โดยใหเลือกกําหนดขั้นตอนการทํางาน
ของคําสั่งดังนี ้(Options → More Options → Read) 

• Code 
• Calibration 
• Data 
• Used ID 
• Configuration 
• Device ID 
 

 ใหเลือกการทาํงานของคาํสัง่ Blank Check โดยใหเลอืกกําหนดขั้นตอนการ
ทํางานของคําสั่งดังนี ้(Options → More Options → Blank Check) 

• Code 
• Data 
• Configuration 
 

 ใหเลือกการทาํงานของคาํสัง่ Erase โดยใหเลือกกําหนดขั้นตอนการทํางาน
ของคําสั่งดังนี ้(Options → More Options → Erase) 

• Code 
• Data 
• Configuration / User ID 

 
ซึ่งหลงัจากกาํหนดคาตวัเลือกตางๆเหลานีเ้ปนทีเ่รียบรอยแลว คาทีก่ําหนดไวแลวนี้ จะคงอยู

ตลอดไปจนกวา จะมีการสัง่แกไขคาตัวเลือกเหลานี้ใหม ดังนั้นในครั้งตอๆไปก็สามารถเรียกใชงานโปรแกรม
ผานคําสัง่ตางๆที่ตองการไดทันที โดยไมจาํเปนตองมาทาํการกาํหนดคาเหลานี้อีกตอไป 
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9. ในการสัง่งานโปรแกรมนั้นสามารถทําได 3 แบบ คือการสั่งงานผานเมนูคําสัง่ หรือ การสัง่งานผาน 
Button ของคําสั่ง หรือการสัง่งานผานคียลัด (Hot Key) ของแตละคําสั่ง โดยไมวาจะเลือกใชวิธกีาร
ส่ังงานโปรแกรมดวยวิธกีารใดก็จะใหผลการทํางานที่เหมือนกนั โดยในการสัง่งานโปรแกรมมีดังนี ้

 ส่ังเปด Hex File ที่จะตองจะส่ังโปรแกรมไปยังหนวยความจาํของ MCU โดยใชเมนูคําสัง่ 
“File → Open…” หรือกดคีย “CTRL+O” หรือคลิกเมาสที่ Button คําสั่ง  แลวเลือก
กําหนดชื่อและที่อยูของ Hex File ตามตองการ 

 ส่ังตรวจสอบคา Configuration ของ MCU โดยใชคําสั่ง “View Configuration” หรือกดคีย 
“CTRL+F” หรือคลิกเมาสที ่ Button คําสั่ง  ซึ่งจะปรากฏหนาตางโปรแกรมสําหรบั
แสดงคา Configuration ของ MCU ที่ไดจาก Hex File ที่ส่ัง Open ไวแลวดังตัวอยาง 

 

 
 

รูปแสดงคา Configuration ของ dsPIC30F2010 ที่จะใชกับบอรด “ET-dsPIC30F2010” 
 

 ซึ่งตามปรกติแลวคาของ Configuration เหลานี้จะถกูกาํหนดไวในขั้นตอนของการพฒันาโปรแกรม
อยูแลว โดยผูใชตองรูและเขาใจเองวาโปรแกรมที่พฒันาขึ้นมามกีารทาํงานอยางไร จําเปนตองใชทรัพยากร
ใดบาง และการทํางานของโปรแกรมเกี่ยวของกับคาของ Configuration ใดๆบาง เพื่อจะไดกําหนดคาการ
ทํางานของ Configuration ใหกับโปรแกรมไดอยางถกูตองและสอดคลองกับโปรแกรม ซึ่งถาใชตัวแปลคําสั่ง
ของ Microchips นั้นคาของ Configuration จะถูกรวมไวใน Hex File ในขั้นตอนของการสัง่แปลโปรแกรม
ดวยอยูแลว โดยคาของ Configuration นี้จะเปลี่ยนแปลงไปตามขอมูลที่ไดจากการสั่ง Open Hex File 
ข้ึนมาในโปรแกรมโดยอัตโนมัติ แตอยางไรก็ตามถาหากวาในขัน้ตอนของการพัฒนาโปรแกรมนั้น ผูใชไมได
กําหนดคาของ Configuration ที่ถูกตองไวดวย ก็อาจสงผลทาํให MCU ไมสามารถทํางานไดอยางถกูตอง
ตามที่ตองการ โดยในกรณีของบอรด “ET-dsPIc30F2010” นั้นตองกาํหนดคาตัวเลอืกดังรูป 
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 ส่ังโปรแกรมขอมูลจาก Buffer (จาก Hex File) ใหกับหนวยความจําของ MCU โดยสั่งผาน
เมนูคําสัง่ “Program → Program” หรือกดคีย “CTRL+P” หรือคลิกเมาสที่คําสัง่  
โดยการทํางานของคําสัง่นี้จะเปนการสั่ง Download ขอมูลจาก Hex File ที่ส่ังเปดไวแลว
ไปยังหนวยความจําของ MCU ซึ่งหลงัจากเสร็จเรียบรอยแลวเมื่อเลือดสวิตชกําหนดโหมด
การทาํงานของบอรดกลับไปยังตําแหนง “RUN” จะเห็นวา MCU เร่ิมตนทํางานตามคําสั่ง
ในโปรแกรมทีส่ั่ง Download ใหในทนัที ่ โดยการทํางานของคําสัง่นี้จะมีลําดับข้ันตอนและ
กระบวนการทาํงานของคาํสัง่ตามที่กาํหนดไวแลวในขางตนอนัไดแก  

 Erase (Code ,Data ,Configuration/Used ID)  
 Program(Code, Data ,Configuration) 
 Verify(Code ,Data ,Configuration) 

 

 
↓ 

 

 
↓ 

 

 
 

รูปแสดง ลําดับขั้นการทาํงานของการสั่งงานดวยคําสั่ง “Program” 
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การตรวจสอบปญหา MCU ไมทํางานหลังการ Download แลว 
 ตามปรกติแลวหลงัจากทีท่ําการ Download Hex File ใหกับ MCU เปนที่เรียบรอยแลว หลังจากที่
เปลี่ยนโหมดการทํางานของบอรดจาก “PROG” มาเปน “RUN” เปนทีเ่รียบรอยแลว MCU จะเริ่มตนทาํงาน
ตามคําสั่งในโปรแกรมที่ทาํการ Download ใหทนัท ี ซึง่ถาเกิดปญหาหรือขอผิดพลาดขึ้นในระหวางขัน้ตอน
ของการ Download โปรแกรมนั้น โปรแกรมก็จะแจงขอผิดพลาดนัน้ๆใหทราบอยูแลว แตสําหรับในกรณีที่
ข้ันตอนของการ Download ไมเกิดอาการผิดพลาดใดๆเลย แต MCU ไมทํางานตามที่ตองการ หลังจากที่
การ Download เสร็จส้ินไปเรียบรอยแลว ปญหาที่มักพบอยูเสมอๆไดแก 

 การกําหนดคา Configuration ของ MCU กอนการสัง่ Download ไมถูกตองและสัมพันธ
กับฮารดแวรทีใ่ชงานอยู ซึง่ปญหานี้เปนปญหาที่พบบอยที่สุด ทั้งนี้ก็เนื่องมากจากวา การ
ทํางานของ MCU ตระกูล dsPIC นั้นจะใช Configuration เปนตัวกําหนดเงื่อนไขการ
ทํางานของวงจรภายในตางๆ ไมวาจะเปนการเลือกการทํางานของสญัญาณนาฬิกา การ
กําหนดการทาํงานของวงจร Watchdog และวงจร Brown-Out Detect ตางๆ ซึ่ง
รายละเอียดของคา Configuration ตางๆโดยละเอียดนัน้ ผูใชสามารถศึกษารายละเอียด
ไดจากหวัขอการกําหนดคา Configuration ของ dsPIC30F2010 แตในทีน่ี้จะขอกลาวถึง
เฉพาะในสวนที่ตองกาํหนดใหสอดคลองกับระบบฮารดแวรของ “ET-dsPIC30F2010” 
เทานั้น ซึง่ไดแก 

 สัญญาณนาฬกิาของบอรด “ET-dsPIC30F2010” จะใชวงจรกําเนดิความถี่
แบบ XTAL คา 7.3728 MHz โดยตอกับขาสัญญาณ OSC1 และ OSC2 โดย
ที่ MCU เบอร dsPIC30F2010 สามารถรับความถี่จากตัวกําเนิดความถี่แบบ 
XTAL ไดสูงสุด 10MHz และทํางานไดทีความถี่สูงสุด 120 MHz ดังนัน้เพื่อให
สามารถใชงาน MCU ไดอยางเตม็ประสทิธิภาพ จําเปนตองกาํหนดใหวงจร
คูณความถี่ (PLL) ทํางานดวย โดยคาอตัราการคูณความถี่ ทีเ่หมาะสมกับ
บอรด “ET-dsPIC30F2010” มากที่สุดคือ 16 เทา ซึ่งจะทําให MCU ทาํงานที่
ความถี ่117.9648 MHz โดยโปรแกรมตัวอยางตางๆทีจ่ดัทําขึ้นโดย อีทีที นัน้
จะอางองิคาความถี่ของสัญญาณนาฬิกาคา 117.9648 MHz เปนหลักดวย
เชนเดียวกนั โดยผูใชตองกาํหนดคา Configuration สําหรับเลือกสญัญาณ
นาฬิกาใหกับ MCU ดวยคาตัวเลือกดังนี ้

• กําหนด Oscillator Source เปน Primary Oscillator 
• กําหนด Primary Oscillator Mode เปน “XT w/PLL1 6X” 

ซึ่งถาผูใชเลือกกําหนดคา Configuration เปนอยางอืน่ จะทําให MCU ไม
ทํางานหรือทํางานไดไมถูกตองตามที่กําหนดไว 
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 การทาํงานของ Watchdog ควรกําหนดเปน “Disable” ไวกอน เพื่อเปนการ
ส่ังปดการทํางานของ Watchdog ไมใหทาํงาน เนื่องจากถากําหนดใหวงจร 
Watchdog ทํางานอยูแตโปรแกรมที่ผูใชเขียนขึ้นไมรองรับการใชงานรวมกบั 
Watchdog ดวย อาจเกิดความผิดพลาดขึ้น โดย MCU จะถูก Watchdog ส่ัง 
Reset อยูเร่ือยๆทําใหการทาํงานของโปรแกรมไมตอเนือ่ง ซึ่งดูเหมือน MCU 
ทํางานผิดพลาด โดยโปรแกรมตัวอยางของทาง อีทีท ี ก็จะไมไดจัดการเรื่อง 
Watchdog ดวยเชนกนั ดังนั้นถาตองการใชงานตัวอยางโปรแกรมของ อีทีท ี
ดวยจะตองสัง่ปดการทาํงานของ Watchdog ดวยเสมอ 

 
แตอยางไรก็ตาม ตัวอยางโปรแกรมทั้งหมดที่เขียนขึ้นโดย อีทที ี นัน้ไดทําการกาํหนดคาการ

ทํางานของ Configuration ตางๆที่เหมาะสมไวใน Source Code ของโปรแกรมดวยอยูแลว ผูใช
สามารถสัง่ Download Hex File ของตัวอยางโปรแกรมจาก อีทที ีตามคา Configuration ที่ไดจาก 
Hex File ไดทันทีโดยไมตองดัดแปลงหรือแกไขคา Configuration ใดๆใหเสียเวลาอีก 

 
 สวิตชเลือกโหมดถูกเลื่อนกลับมายงัตําแหนง “RUN” ไมหมดทําใหขาสัญญาณ MCLR ไม
เชื่อมตอกับวงจร RESET อยางถูกตองจงึทําให MCU ไมทํางาน 

 โปรแกรมที่ผูใชเขียนขึ้นนัน้ไมสามารถทาํงานไดอยางถกูตองเองอยูแลว ซึ่งปญหานี้อาจ
ทดสอบได โดยการทดลองสัง่ Download โปรแกรมตัวอยางที่ส่ังแปลเปน Hex File ไว
เรียบรอยแลว ซึ่งโปรแกรม ตัวอยาง ตางๆเหลานี้ ไดรับการทดสอบ แลววามีความถูกตอง
และทํางานไดจริงตามเงื่อนไขที่ทาง อีททีี กําหนดไว 

 ในกรณีที่การสั่ง Run โปรแกรม “melabs Programmer” แลวเกดิการผิดพลาดเรื่องการ 
โหลด Driver แสดงวาในขั้นตอนของการตดิตั้งโปรแกรมนั้นผูใชยังไมไดส่ังติดตั้ง Driver ไว
ดวย ใหทําการสั่งติดตั้ง Driver ใหเรียบรอยโดยสั่งงานผานเมนูคําสัง่ของ Windows โดยใช 
“Start → Program melabs → Programmer Beta → NT,2000,XP Driver Installer” 
จากนั้นก็จะสามารถเรยีกใชงานโปรแกรม “melabs Programmer” ไดตามปรกต ิ
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การกําหนดคา Configuration ใหกับ dsPIC30F2010 
 
 สําหรับ dsPIC30F2010 นั้นจะมีรีจิสเตอรพิเศษจํานวน 4 ชุด ซึ่งเรียกวา Configuration  Register 
สําหรับใชกาํหนดคุณสมบัติและควบคุมการทํางานของวงจรตางๆใน MCU ซึ่งการกาํหนดคาใหกบั
รีจิสเตอรพิเศษทั้ง 4 ชุดนี ้จะตองกระทําในข้ันตอนของการโปรแกรมดวยวิธกีารแบบ ICSP หรือจากเครื่อง
โปรแกรมภายนอกเทานั้น 
 โดยสําหรับบอรด Et-dsPIC30F2010 START KIT V1 / EXP นั้น ในกรณีที่ใชการพัฒนาโปรแกรม 
รวมกับชุดพฒันา “ET-CAP10 V2.0” รวมกับโปรแกรม “WinPic800” หรือ “melabs Programmer” นั้น จะ
สามารถกําหนดคาตัวเลือกตางๆใหกับ Configuration Register ผานทางหนาจอของโปรแกรมโดยตรง หรือ
กําหนดคาจากคา Configuration ที่ไดจาก HEX File ของ MPLAB C30 ก็ได ดังตัวอยาง 
 
/* Setup Configuration For ET-dsPIC30F2010 */ 
_FOSC(CSW_FSCM_ON &   // Enable Clock Switching 
      XT_PLL16);    // Enable Fail-Safe Clock 
                                                               //  Clock Source = Primary XT  
       // Enable Phase Lock Loop x 16 
_FWDT(WDT_OFF);   // Disable Watchdog  
_FBORPOR(PBOR_ON &    // Enable Brown-Out 
   BORV_45 &    // Brown-Out = 4.5 Volt 
   PWRT_64 &    // Power ON = 64 mS 
   MCLR_EN);   // Enable MCLR 
_FGS(CODE_PROT_OFF);  // Code Protect OFF 
/* End   Configuration For ET-dsPIC30F2010 */ 

 
 โดยรายรายละเอียดและ Keyword ของ Macro ทั้งหมดที่ใชในการกาํหนดคา Configuration ของ 
dsPIC30F2010 นั้น ผูใชสามารถดูไดจาก “..\pic30_tools\support\h\p30f2010a2.h” 
 
 ***หมายเหต*ุ** สําหรับบอรด ET-dsPIC30F2010 Training Kit V1.0 / EXP ของ อีททีี นัน้ ถา
ตองการใชงานกับโปรแกรมตัวอยางตางๆที่ทางอทีีท ี จดัทําขึ้นโดยไมเกิดปญหา จะตองเลือก Oscillator 
เปนแบบ “Primary” โดยใช “XT w/PLL 16X-XT crystal oscillator mode with 16X PLL” พรอมกับ
ยกเลิกบิต “FWDTEN” เพื่อปดการทํางานของ Watchdog ดวยเสมอ สวนตวัเลือกอื่นๆสามารถเลือก
กําหนดไดตามตองการ 
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FOSC (Oscillator Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80000H 

ทําหนาที่สําหรับใชเลือกกําหนดคุณสมบติัและแหลงกาํเนิดของสัญญาณนาฬิกาทีจ่ะปอนใหกับ MCU ของ 
MCU เพื่อใชเปนสัญญาณนาฬิกาของระบบ ซึ่งตามปรกติแลวระบบสัญญาณนาฬกิาของ dsPIC30F2010 
จะสามารถเลอืกกําหนดไดหลายแหลงขึน้อยูกับการออกแบบวงจรใชงาน แตในกรณีทีใ่ชกับบอรด ET-
dsPIC30F2010 นั้น ระบบสัญญาณนาฬิกาจะไดรับการออกแบบใหใชงานกับตัวกําเนิดความถี่
แบบ XTAL คา 7.3728MHz และเพื่อใหสามารถใชงาน MCU ไดอยางเต็มประสิทธภิาพและ
สามารถใชงานกับตัวอยางโปรแกรมตางๆ ที่ทาง อีทีที จัดทาํขึน้ ไดโดยไมเกิดปญหาจะตองเลือก
กําหนดแหลงกําเนิดของสัญญาณนาฬิกาเปนแบบ “Primary Oscillator” รวมกับ “XT w/PLL 16x”  
เทานั้น ซึง่การเลือกคาดังกลาวเปนการเลือกกําหนดให MCU ใชสัญญาณนาฬิกาจากวงจรกาํเนิดความถี่
แบบ XTAL ซึ่ง ตอเขากับขา OSC1 และ OSC2 พรอมทั้งเปดการทาํงานของวงจรคูณความถี ่Phase-Lock-
Loop ดวยอัตราการคูณ 16 เทา ดวย ซึ่งจะสงผลใหคาความถีข่องสัญญาณนาฬิกาของบอรด ET-
dsPIC30F2010 มีคา 117.9648 MHz ซึ่งความถี่ของสญัญาณนาฬิกาดังกลาวจะถกูนําไปหารใหเหลือ ¼ 
กอนทีจ่ะปอนใหกับระบบของ MCU ดังนัน้คาความถี่ของสัญญาณนาฬกิาของระบบ ที่ใชในบอรด ET-
dsPIC30F2010 จะมีคาเทากับ 29.4912 MHz สําหรับรายละเอยีดการเลือกกาํหนดคาของบิตตางๆใน 
PSOC Configurations Register จะมีดังตอไปนี้ 
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต FCKSM[1:0] - - - - FOS[1:0] 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - - - FPR[3..0] 

  

ตาราง แสดงคาบิตตางๆของ FOSC Configurations Register 
 

- FCKSM[1:0] ใชสําหรับกาํหนดการทํางานของวงจรสลับสัญญาณนาฬิกาและตรวจสอบการ
ทํางานของสญัญาณนาฬิกา   

 0:0 = เปนการเลือกเปดการทํางาน (Enable) ทั้งสวนของวงจรสลับสัญญาณนาฬิกา 
และ วงจรตรวจสอบความผดิพลาดของสญัญาณนาฬิกา(Fail-Safe Clock Monitor) 

 0:1 = เปนการเลือกเปด (Enable) การทาํงานของวงจรสลับสัญญาณนาฬกิา แตใน
สวนของวงจรตรวจสอบความผิดพลาดของสัญญาณนาฬิกาจะถูกปด (Disable) ไว 
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 1:X = เปนการเลือกปด (Disable)ทั้งสวนของวงจรสลับสัญญาณนาฬิกา และ วงจร
ตรวจสอบความผิดพลาดของสัญญาณนาฬิกา (Fail-Safe Clock Monitor) 

 
- FOS[1:0] ใชสําหรับเลือกแหลงกาํเนิดสญัญาณนาฬิกาของ MCU ซึ่งสามารถเลือกได 4 แบบ 

แตสําหรับในกรณีของบอรด ET-dsPIC30F2010 ควรเลอืกเปน “1:1” เทานั้น 
 0:0 = เลือกใชสัญญาณนาฬกิาจาก XTAL 32KHz ภายใน MCU 
 0:1 = เลือกใชสัญญาณนาฬกิาจาก RC ภายในแบบยานความถี่สูง 
 1:0 = เลือกใชสัญญาณนาฬกิาจาก RC ภายในแบบยานความถี่ตํ่าและใชพลังงานต่ํา 
 1:1 = เลือกใชสัญญาณนาฬิกาจาก Primary Oscillator โดยกําหนดคุณสมบัติการ
ทํางานของวงจรรวมกับบิต FPR[3:0] อีกตอหนึง่ 

 
- FPR[3:0] ใชสําหรับเลือกการทํางานของสัญญาณนาฬกิาของ Primary Oscillator ซึ่งคาของ

ตัวเลือกในสวนนี้จะมีผลตอการทาํงานของ MCU ก็ตอเมื่อเลือกกาํหนดแหลงของสัญญาณ
นาฬิกาเปน Primary Oscillator แลว โดยคุณสมบัติการทํางานของ FPR{3:0] มีดังนี ้

 000x = “XLT” เปนการเลือกใช XTAL คา 200KHz-4MHz ตอกับขา OSC1,OSC2 
 001x = “HS” เปนการเลือกใช XTAL คา 10MHz-25MHz ตอกับขา OSC1,OSC2 
 0100 = “XT” เปนการเลือกใช XTAL คา 4MHz-10MHz ตอกับขา OSC1,OSC2 
 0101 = “XT PLL 4x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขากับ 

OSC1 และ OSC2 โดยเปดการทาํงานของวงจรคณูความถี่ (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 4 เทาของความถี ่XTAL ดวย 

 0110 = “XT PLL 8x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขากับ 
OSC1 และ OSC2 โดยเปดการทาํงานของวงจรคณูความถี่ (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 8 เทาของความถี ่XTAL ดวย 

 0111 = “XT PLL 16x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขา
กับ OSC1 และ OSC2 โดยเปดการทํางานของวงจรคณูความถี ่ (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 16 เทาของความถี่ XTAL ดวย 

 1000 = “ERCIO” เปนการเลือกใชสัญญาณนาฬิกาจากวงจร RC ภายนอก โดยตอ
เขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกต ิ

 1001 = “ERC” เปนการเลือกใชสัญญาณนาฬิกาจากวงจร RC ภายนอก โดยตอ
สัญญาณนาฬกิาเขากับขา OSC1 สวน OSC2 จะใชเปน Output ของสัญญาณ
นาฬิกาที่ได โดยมีคาความถี่เปน ¼ หรือ Fosc/4 



คูมือการใชงานบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP 

ETT CO.,LTD -43- WWW.ETT.CO.TH 
 

 1011 = “EC” เปนการเลือกใชสัญญาณนาฬกิาคา 0-40MHz จากแหลงกาํเนิด
ภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน Output ของสัญญาณ
นาฬิกาที่รับจาก OSC1 โดยมีคาความถี่เปน ¼ หรือ Fosc/4 

 1100 = “ECIO” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จากแหลงกาํเนิด
ภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 

 1101 = “EC PLL 4x” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จาก
แหลงกาํเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทาํงานของวงจรคูณความถี ่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 4 เทาของความถีท่ี่ปอนใหกับขา OSC1 ดวย 

 1110 = “EC PLL 8x” เปนการเลอืกใชสัญญาณนาฬกิาคา 0-40MHz จาก
แหลงกาํเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทาํงานของวงจรคูณความถี ่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 8 เทาของความถีท่ี่ปอนใหกับขา OSC1 ดวย 

 1111 = “EC PLL 16x” เปนการเลอืกใชสัญญาณนาฬกิาคา 0-40MHz จาก
แหลงกาํเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทาํงานของวงจรคูณความถี ่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 16 เทาของความถี่ทีป่อนใหกับขา OSC1 ดวย 

 
หมายเหต ุ การกําหนดคา Configuration ของ FOSC นั้น จะมีผลตอการทาํงานของ MCU 

โดยตรง ซึ่งถากําหนดไมถูกตองจะทาํให MCU ไมสามารถทาํงานได หรือทาํงานไดไมถูกตอง ถงึแมวาผูใช
จะเขียนโปรแกรมไดอยางถกูตองทกุประการก็ตามท ี โดยในกรณีของการใชงานบอรด “ET-
dsPIC30F2010” นัน้ จะเห็นไดวาวงจรกําเนิดความถีจ่ะถูกออกแบบใหใชตัวกาํเนิด XTAL คา 7.3728 
MHz ตอกับขา OSC1 และ OSC2 ของ MCU โดยตรง ซึง่นัน่กห็มายความวาการกาํหนดคา Configuration 
ของ FOSC ทีจ่ะใชงานกับบอรด “ET-dsPUIC30F2010” นั้นจะตองกาํหนดเปน Primary แบบ XT เทานั้น 
ซึ่งถาเลือกเปนอยางอื่นจะทําให MCU ไมสามารถทาํงานได แตในกรณีที่ตองการใชงานตัวอยางโปรแกรมที่
สรางโดย อีททีี จะตองกําหนดการทํางานของ FOSC ใหเปดการทํางานของวงจรคณูความถี่จากตัวกําเนิด
ความถี่คา 7.3728MHz ดวยอัตรา 16 เทาดวย (XT PLL16X) ถาเลือกเปน XT หรือ XT PLL 4 หรือ XT PLL 
8 ถึงแมวา MCU จะสามารถทํางานได แตก็จะสงผลทาํใหไดคาความถี่ ไมตรงกับที่คํานวณไวในโปรแกรม
จะทําใหการทาํงานของโปรแกรมไมถูกตอง เชน ความเร็วของการทํางานชาลง คาอัตรา Baud rate ของ
พอรตสื่อสารอนุกรมผิดเพีย้นไปเปนตน ดังนัน้ตองกาํหนดคา Configuration ของ FOSC เปนแบบ “XT 
PLL16” เสมอ MCU จึงจะทาํงานไดอยางถูกตอง 



คูมือการใชงานบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP 

ETT CO.,LTD -44- WWW.ETT.CO.TH 
 

FWDT (Watchdog Timer Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80002H 

ใชสําหรับกาํหนดการทํางานของ Watchdog ซึ่งในกรณทีี่ใชกับบอรด ET-dsPIC30F2010 และตองการใช
งานรวมกบัโปรแกรมตัวอยางตางๆที่ทางอทีีทีจัดทําขึน้ ควรกําหนดคาของบิต “PWTEN” ใหเปน “0” เพื่อ
ปดการทาํงานของ Watchdog ไวกอน ซึง่ถาตองการใชงาน Watchdog ผูใชอาจทาํการปรับปรุงการทาํงาน
ของโปรแกรมที่เขียนขึน้ โดยเพิ่มคําสั่งสาํหรับรีเซ็ตคาการนับของ Watchdog ในสวนตางๆของโปรแกรม
ตามความเหมาะสมแลวจงึสัง่เปดการทํางานของ Watchdog ในภายหลัง โดยคาตวัเลือกตางๆของ FWDT 
มีดังนี ้
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - FWPSA[1:0] FWPSB[3:0] 

 
 

ตาราง แสดงคาบิตตางๆของ FWDT Configurations Register 
 

- FWTEN ใชสําหรับกาํหนดการทาํงานของ Watchdog โดยถากําหนดใหบิตนี้เปน “1” จะเปน
การสั่งเปดการทํางานของ Watchdog ซึ่งในกรณนีี้ผูใชตองเขียนคาํสั่งเพื่อส่ังรีเซ็ตคาการนับ
ของ Watchdog กอนเกิดการ Overflow ในสวนตางๆของโปรแกรมเองดวย ไมเชนนั้นแลวเมื่อ
การนับของ Watchdog เกิดการ Overflow ข้ึน วงจร Watchdog จะสั่งรีการทํางานของ MCU 
ใหเร่ิมตนใหมทันที แตถากําหนดคาของบิตนี้ใหเปน “0” จะเปนการปดการทํางานของ 
Watchdog ซึ่งขอแนะนําใหส่ังปดการทาํงานของ Watchdog ไปกอน จนผูใชสามารถเขยีน
โปรแกรมไดอยางชาํนาญแลว ถาตองการใชงานวงจร Watchdog จึงคอยสั่งเปดการทํางาน
ของ Watchdog ตามตองการในภายหลัง 

- FWPSA[1:0] ใชสําหรับกําหนดคา Prescaler ของวงจร Prescale ชุด A เพื่อกาํหนดคาการ
ลดทอนความถี่สัญญาณนาฬิกาที่จะปอนใหกับวงจร Prescale ชุด B เพื่อใชเปนคาการนับ
ของ Watchdog 

 0:0 = กําหนดการ Prescale เปน 1:1 
 0:1 = กําหนดการ Prescale เปน 1:8 
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 1:0 = กําหนดการ Prescale เปน 1:64 
 1:1 = กําหนดการ Prescale เปน 1:512 

- FWPSB[3:0] ใชสําหรับกาํหนดคา Prescale ของวงจร Prescale ชุด B เพื่อกําหนดคาการนบั
ของ Watchdog โดยสามารถกําหนดได 16 ระดับคือ 

 0000 = กําหนดการ Prescale เปน 1:1 
. 
. 

 1110 = กําหนดการ Prescale เปน 1:15 
 1111 = กําหนดการ Prescale เปน 1:16 

 
หมายเหต ุการทํางานของวงจร Watchdog นัน้จะชวยเพิ่มประสทิธภิาพการทํางานของ MCU ใน

การใชงานใหเกิดประสิทธิภาพสงูสุด โดยในระบบไมโครคอนโทรเลอรนั้น จะอาศัย Watchdog ชวย
ตรวจสอบการทํางานของ MCU ไมใหหยุดทํางาน ซึง่เหมาะกับการใชงานวงจรทีต่องทําการอยางตอเนื่อง
ตลอดเวลาเปนเวลานานๆ ซึ่งหลกัการทํางานของวงจร Watchdog นั้นจะเปนวงจรนับอิสระวงจรหนึ่ง ซึง่
สามารถกําหนดคาการของจํานวนการนบัสูงสุด (Time-Out) ที่แนนอนใหกับวงจรได โดยเมือ่วงจรการนับ
ของ Watchdog นับไปจนถงึคาการนับสูงสุดแลวคาการนับจะกลบัมาเริ่มตนใหม ซึง่เรียกวาการ Overflow 
โดยในชวงนี้จะทําใหวงจร Watchdog สงสัญญาณไปรีเซ็ตการทํางานของ MCU ใหเร่ิมตนทํางานใหม 

ซึ่งเราจะใชประโยชนจากวงจร Watchdog ในการตรวจสอบการทาํงานของ MCU โดยการเขียน
คําสั่งสําหรับส่ังรีเซ็ตคาการนับของ Watchdog แทรกไวในสวนตางๆของโปรแกรม กอนที่คาการนับของ 
Watchdog จะเกิดการ Overflow ข้ึน แตถาหากวา MCU เกิดการหยุดการทํางานขึ้น ไมวาจะเกิดจาก
สาเหตุใดก็ตาม MCU ก็จะไมสามารสงสญัญาณไปรีเซ็ตคาการนับของ Watchdog ไดดังนั้น MCU ก็จะถูก 
Watchdog รีเซ็ตใหกลับมาเริ่มตนทาํงานใหมไดอีก 

แตอยางไรก็ตามในการพฒันาโปรแกรมใชงานนัน้ ถาผูพัฒนาโปรแกรมยังไมมีความชํานาญในการ
เขียนโปรแกรมเพียงพอ โดยเฉพาะในระหวางที่เปนชวงเริ่มตนของการเรียนรูนัน้ ควรสั่งปดการทํางานของ 
Watchdog ไวกอน ไมเชนนั้นแลวจะเปนการเพิม่ความสับสนใหกับผูใชได เนื่องจากถามีการแทรกคําสั่ง
สําหรับรีเซ็ตคาการนับของ Watchdog ไมเหมาะสมก็อาจทาํให Watchdog ส่ังรีเซ็ตการทํางานของ MCU 
ในขณะที ่ MCU กําลงัทาํงานตามโปรแกรมปรกติอยูก็เปนได ดังนัน้ขอแนะนาํใหส่ังปดการทํางานของ 
Watchdog ไวกอน จนเมือ่สามารถพัฒนาโปรแกรมรวมกับวงจรสวนอื่นๆ จนโปรแกรมสามารถทํางานได
อยางถูกตองครบทั้งหมดแลว จึงคอยเปดการทาํงานและแทรกคําสัง่สาํหรับ รีเซ็ตคาการนับของ Watchdog 
ในภายหลัง ซึ่งตัวอยางโปรแกรมตางๆทีท่าง อีททีี จัดทําขึ้นนัน้กไ็มไดจัดการเรื่อง Watchdog ไวดวย
เชนเดียวกนั ดังนัน้ควรกาํหนดคา Configuration ของ FWDT ใหปดการทํางานของ Watchdog ไวดวย 
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FBORPOR (BOR and POR Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80004H 

ใชสําหรับกาํหนดการทํางานของวงจร Power-ON Reset และ Brown-Out Reset 
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต MCLREN - - - - PWMPIN HPOL LPOL 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต BOREN - BORV[1:0] - - FPWRT[1:0] 

 
 

ตาราง แสดงคาบิตตางๆของ FBORPOR Configurations Register 
 

- MCLREN ใชสําหรับกาํหนดการทํางานของขาสัญญาณ MCLR โดยถากาํหนดใหบิตนี้มีคา
เปน “1” จะเปนการเปดการทํางาน (Enable) ของขาสัญญาณ MCLR เปน External Reset 
ตามปรกติ แตถากําหนดใหบิตนี้มีคาเปน “0” จะเปนการปดการทํางาน (Disable) ของ
ขาสัญญาณ MCLR 

- PWMPIN ใชสําหรับกาํหนดการทํางานของขาสัญญาณ PWM ในระหวางการรีเซ็ต ซึ่งใน 
dsPIC30F2010 จะมีอยู 3 ชุด โดยถากาํหนดใหบิตนีม้ีคาเปน “1” จะเปนการกาํหนดใหขา 
Output ของ PWM ถูกควบคุมโดยวงจร Input/Output และมีสถานะเปน Tri-State ในระหวาง
เกิดการรีเซ็ตอยู แตถากาํหนดใหบิตนี้มีคาเปน “0” จะเปนการกาํหนดใหขา Output ของ PWM 
ถูกควบคุมจากวงจร PWM โดยในขณะเกดิการรีเซ็ตอยูจะมีสถานะเปน Output  

- HPOL ใชสําหรับกําหนดลกัษณะการทํางานของขา PWMH เมื่อเกดิการทํางาน (Active) โดย
ถากาํหนดใหบิตนี้มีคาเปน “1” จะเปนการกําหนดใหขาสัญญาณ PWMH เปน High ในขณะ 
Active แตถากําหนดใหบิตนี้เปน “0” จะเปนการกําหนดให PWMH เปน Low ในขณะ Active 

- LPOL ใชสําหรับกําหนดลักษณะการทํางานของขา PWML เมื่อเกดิการทํางาน (Active) โดย
ถากาํหนดใหบิตนี้มีคาเปน “1”จะเปนการกําหนดใหขาสัญญาณ PWML เปน High ในขณะ 
Active แตถากําหนดใหบิตนี้เปน “0” จะเปนการกําหนดให PWML เปน Low ในขณะ Active 

- BOREN ใชสําหรับกาํหนดการทาํงานของวงจร Brown-Out Reset โดยถากาํหนดเปน “1” จะ
เปนการเปดการทํางานของ Brown-Out แตถากาํหนดเปน “0” จะเปนการปดการทํางานของ 
Brown-Out 
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- BORV[1:0] ใชสําหรับกาํหนดระดับคาของแรงดันที่จะใชเปนจุดอางอิงในการตรวจสอบความ
ผิดพลาดของระดับแหลงจายของวงจร Brown-Out Reset 

 0:0 = ใหวงจร Brown-Out ทํางานเมื่อแรงดันต่ํากวา 4.5V 
 0:1 = ใหวงจร Brown-Out ทํางานเมื่อแรงดันต่ํากวา 4.2V 
 1:0 = ใหวงจร Brown-Out ทํางานเมื่อแรงดันต่ํากวา 2.7V 
 1:1 = ใหวงจร Brown-Out ทํางานเมื่อแรงดันต่ํากวา 2.0V 

 
- FPWRT[1:0] ใชสําหรับกาํหนดคาเวลาการทํางานของวงจร Power-ON Reset 

 0:0 = เปนการปดการทาํงาน (Disable) ของวงจร Power-ON Reset 
 0:1 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 4mS 
 1:0 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 16mS 
 1:1 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 64mS 
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FGS (General Code Segment Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที ่F8000AH 

ใชสําหรับกาํหนดระบบการปองกันขอมูลของหนวยความจําใน MCU 
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - - - - - GCP GWRP 

 
 

ตาราง แสดงคาบิตตางๆของ FGS Configurations Register 
 
 

- GCP ใชสําหรับกําหนดการปองกนัการอานขอมูลของหนวยความจําโปรแกรม หรือ Flash 
Memory จากภายนอก โดยถากาํหนดใหบิตนี้เปน “1” จะเปนการปด (Disable) ระบบปองกนั
การอานขอมูลจากหนวยความจํา Flash แตถาเลือกกาํหนดใหบิตนีเ้ปน “0” จะเปนการเปด 
(Enable) ระบบปองกนัการอานขอมูลจากหนวยความจํา Flash ซึ่งจะทําใหไมสามารถสั่งอาน
ขอมูลจากหนวยความจํา Flash ใน MCU จากภายนอกได โดยถาเลือกกําหนดใหบิตนี้มีคา
เปน “0” แลวจะไมสามารถสั่งเปลี่ยนคาใหกลับมาเปน “1” ไดอีก นอกจากจะสั่งลบขอมูลออก
จากหนวยความจําทัง้หมดเสียกอน ซึ่งหลงัจากสั่งลบขอมูลในหนวยความจําโปรแกรมทั้ง
หมดแลวบิตนีจ้ะมีคาเปน “1” โดยอัตโนมัติ 

- GWRP ใชสําหรับกําหนดการปองกนัการเขียนขอมูลของหนวยความจําโปรแกรม หรือ Flash 
Memory โดยถากาํหนดใหบิตนี้เปน “1” จะเปนการปด (Disable) ระบบปองกันการเขียน
ขอมูลใหมใหกับหนวยความจํา Flash แตถาเลือกกําหนดใหบิตนี้เปน “0” จะเปนการเปด 
(Enable) ระบบปองกนัการเขียนขอมูลใหกับหนวยความจํา Flash ซึ่งจะทาํใหไมสามารถสั่ง
เขียนขอมูลใหกับหนวยความจํา Flash ใน MCU เพิ่มเติมไดอีกจนกวาจะสั่งลบขอมูลเดิม
ทั้งหมดออกเสยีกอน โดยถาเลือกกําหนดใหบิตนี้มีคาเปน “0” แลวจะไมสามารถสัง่เปลี่ยนคา
ใหกลับมาเปน “1” ไดอีก นอกจากจะสั่งลบขอมูลออกจากหนวยความจําทัง้หมดเสยีกอน ซึง่
หลังจากสัง่ลบขอมูลในหนวยความจําโปรแกรมทั้งหมดแลวบิตนี้จะมคีาเปน “1” โดยอัตโนมัติ 
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รูปแสดง คา Configuration ที่เหมาะสมของ ET-dsPIC30F2010 โดยใช “WinPic800” 
 
 

 
 

รูปแสดง คา Configuration ที่เหมาะสมของ ET-dsPIC30F2010 โดยใช “melabs Programmer” 
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